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Part 1: Introduction

About this Manual

Intended Use of this Manual

• This manual describes the common use procedures of the PlateWriter 4200 System.
It is intended for the daily users and should be kept with the equipment for
reference at all times.

Reservations

• This manual was written and illustrated using the best possible information
available at the time of publication.

• Any differences between this manual and the equipment reflect improvements
introduced after the publication of the manual.

• Changes, technical inaccuracies and typographic errors will be corrected in
subsequent editions.

• As a part of our policy of continuous improvement, we reserve the right to alter
design and specifications without further notice.

Important!

Safety and Use

• Before using the equipment it is assumed that it has been properly installed and
configured as described in the installation manuals delivered with the system.

• The manufacturer cannot be held responsible for any damage caused by incorrect
use of this equipment.
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Notes, Cautions and Warnings!

Throughout the manual notes, cautions, and warnings are shown with various icons
and written in bold like the example below:

"
NOTE! The cover can only be positioned on the finishing unit if the front
cover is not in place.

Explanation

"
NOTE! The operator should observe and/or act according to the information to
obtain the best possible function of the equipment.

$
CAUTION! The operator must observe and/or act according to the information
to avoid any mechanical or electrical damage to the equipment.

#
WARNING! The operator must observe and/or act according to the
information to avoid any personnel injury.
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The PlateWriter 4200 System

The PlateWriter 4200 System is an innovative and patented inkjet Computer-to-Plate
(iCtP) device.

The PlateWriter System consists of:

• PlateWriter Engine
A specially modified Roland SP-300 inkjet printer that uses Glunz & Jensen's Liquid
Dot fluid to image the iPlates printing plates.

• Plate Alignment Mat
A mat that aligns and carries the plates into the PlateWriter 4200 Engine.

• Proofer
An unmodified Epson Stylus Color 4000 or 7600 printer used for proofing.

• Harlequin RIP Platform
A customized workstation accessible by both Mac and PC computers, loaded with
the latest version of the Global Graphics Harlequin RIP.
The Harlequin RIP provided is customized by Xitron and it accepts PostScript, PDF,
EPS, TIF & JPEG files produced by standard pre-press applications.
It RIPs the data and sends output to the PlateWriter Engine or to the Proofer

• PlateWriter Finishing Unit
An integrated plate finisher that executes all of the steps necessary to produce
press-ready plates, namely: curing, gumming and drying of the plates after they are
imaged in the PlateWriter Engine.
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PlateWriter Overview

1 Front Plate Table: place plates here before printing.
2 Control Panel: from here you control the Imaging Unit (see details on page 1-6).
3 Plate Alignment Mat: holds the printing plate using vacuum and transports it through the

Imaging Unit.
4 Ink Dryer: improves the drying of the Liquid Dot ink on the plate.
5 Rear Plate Table: when a plate has been loaded it will be transported to here before

printing starts.
6 Curing Conveyor: leads the printed plate through the curing sections.
7 Curing Oven: dries the ink on the plate and cross-links it to the aluminum base.
8 Gum/Finishing Bottle: contains the finishing solution applied to the plate in the finishing

section. Solution not accepted by the plate returns into the bottle.
9 Finishing Section: cools the plate and applies a combined gum- and plate enhancer to the

plate to protect it from oxidation and to improve its press characteristics and hydrophilic
properties when on press.

10 Gum Dryer: dries the plate to provide a finished, dry plate.
11 Plate Exit Tray: holds the finished plates.
12 Ink Cartridges: This compartment holds 2 cartridges with Liquid Dot ink for the plate

printing and 2 cartridges with cleaning fluid for cleaning of the tubing system.
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13 Status Indicator LED: indicates the current status of the Finishing Unit.
14 Program Selector: for selection of the Curing Oven program.
15 USB-cable: connects the Imaging Unit with the RIP Workstation.
16 Power Cable: supply voltage for the Imaging Unit.
17 Power Switch: press here to switch the Imaging Unit On/Off.
18 Power Switch: press here to switch the Finishing Unit On/Off.
19 Power Cable: supply voltage for the Finishing Unit.
20 Control Cable: connects the Ink Dryer with the Finishing Unit.
21 Power Cable: supply voltage from Finishing Unit to the Ink Dryer.
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Control Panel

1 [POWER] key: switches the sub power on and off. When on, the built-in light is
illuminated.
When the unit is in SLEEP-mode the light flashes slowly.

2 [ENTER] key: enables setting of values and executes operations - see "Menu Operations"
later in this chapter for details.

3 [MENU] key: displays the main menu - see "Menu Operations" later in this chapter for
details.

4 [PAUSE] key: pauses output operation. Pressing it for one second or longer cancels output
operation. The built-in light is illuminated when operation is paused - see "Pausing or
Cancelling Printing" later in this manual for details.

5 [BUSY] light: lights up when printing is in progress.
6 [SET UP] light:.
7 [EJECT PLATE] key: moves the Plate Alignment Mat out of the printer onto the front plate

table for either loading or unloading of plates.
8 [LOAD PLATE] key: moves the Plate Alignment Mat and plate through the printer and

stops when the unit detects the front edge of the plate.
9 Arrow keys: when at a menu screen, you use these to select setting values or change

screens - see "Menu Operations" later in this chapter for details.
10 [BASE POINT] key: overrides the starting position of the plate set in the above load plate

position. The light is illuminated when the starting position has been changed.
11 [CLEANING] key: pressing and holding this down for one second or longer starts cleaning

of the printing heads.
12 [TEST PRINT] key: Pressing and holding this for one second or longer down starts a nozzle 

check printing.
13 Display: turns off when unit is in SLEEP or OFF-mode.
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Menu Operations

Displaying the Menu

Press the [MENU] key to enter the menu.

Menu Navigation

When in the menu, the keys function as follows:

Up/Down Arrow Keys: Selects a menu item or changes the value
 of a setting.

Right Arrow Key: Displays a menu that is one level lower.

Left Arrow Key: Displays the menu that is one level higher.

[ENTER] key: Executes a menu item or enables a setting value.
The value for any setting in enabled only by pressing this key.

[MENU] key: From any menu screen, pressing this key returns
you to the top menu.

Menu Screen

The figures below show examples of menu screen displays with descriptions of
the operations you can perform when a symbol is displayed.
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ENTER

MEDIUM
HEAD CLEANINGX

Press [ENTER] key to
execute the function

Press [ENTER] key
to enable setting

Use [  ] key to return to
the previous menu screen

Use [  ] and [  ] keys to scroll through
menu items under HEAD CLEANING

Use [  ] and [  ] keys
to change setting

XXX XXXX X92.0 93.0
SET VALUE [mm]X X XX

Use [  ] key to select a
menu that is one level

lower (see below)

SET VALUE [mm]X X XX
FRAME BACKX XXXXXX

MENU



Printer modes

"
NOTE! Once you have switched on the main power, you should not switch it
off unless you are moving the unit or for servicing purposes.

When main power switch is switched on, the PlateWriter can be in various modes as
described below:

OFF-mode

• Main power is switched on.

• Sub power not switched on by the [POWER] key.

STAND BY-mode

• Main power switched on.

• Sub power switched on by the [POWER] key. Built-in light is illuminated.

• Display is illuminated.

• When a fixed interval passes with no operation, the unit automatically switches into
SLEEP-mode (see below).

SLEEP-mode

• Main power switched on.

• Sub power switched on by the [POWER] key. Built-in light flashes slowly.

• Display is off.

• Activating any key on the control panel or sending data from the RIP workstation
(when plate is loaded) makes the unit return to STAND BY-mode.

"
NOTE! To reduce power consumption, we recommend leaving the  
SLEEP-mode feature enabled and setting the interval until the SLEEP-mode is
activated to a time of 30 minutes or less.

MAINTENANCE-mode

• When PlateWriter is in SLEEP-mode or STAND BY-mode it will automatically
perform a maintenance cycle at fixed intervals.

• Even if the PlateWriter is in OFF-mode it will "wake up" at intervals and perform the 
maintenance cycle and then automatically return to OFF-mode.

PROCESS-mode

• Unit is printing. [BUSY] light is illuminated.

SERVICE-mode

For service- and maintenance purposes only - see "How to Power Up the PlateWriter in 
Service Mode" in chapter 3 later in this manual for details.
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Part 2: Daily Use

Overview

The daily use procedures described in this chapter covers the following issues:

• Daily Start-Up procedure

• Loading of plates into the PlateWriter for printing

• Printing of plates.

• Finishing

• Daily Shut-Down procedure

Daily Start-Up

• Start the RIP Workstation (1).

• Launch the RIP Application (2).

continues…
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• Replace the finisher solution in
the finishing bottle (3) with fresh
finisher solution.

"
NOTE! Half a bottle is
sufficient.

• Check that the ink drain bottle
(4) is not full, otherwise empty or
replace it.
See "Disposing of Discharged Ink"
in chapter 3 for details.

• Switch on the Finisher Unit on
the main switch (5) underneath
and… 
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...make sure that indicator (6)
lights steady green.

• The unit will run gum fluid
through the system for
app. 3 mins. to ensure an even
gumming of the plates.

"
NOTE! This will switch on
the Ink Dryer as well.

• Switch on the PlateWriter by
pressing the [POWER] key (7).

• The PlateWriter initializes and
when finished the display (8) 
will say "PLATE LOAD".
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Making a Proof

Creating Files for Proofs

• Use your DTP application to prepare a composite output file - please refer to your
application manual for help.
Select an output page size sufficiently large to accommodate your content and any
registration marks or color bars.

• Save the file to a folder, either on the computer running Navigator RIP or on a
server.

Printing a Proof

• In the Navigator RIP open the Output Controller / Monitor window by either
pressing Ctrl+O or choosing Output -> Output Controller from the RIP menu.

• Be sure that Disable Output is checked.

• Select File -> Print file from the RIP menu.
Choose an appropriate Proofing Page Setup and a file type (.ps, .pdf, .eps, .jpg or .tif) 
from the dialog.
Navigate to the folder containing your composite files, choose one file, and click on
Print.

• The file will be ripped and will appear in the Active Queue of the Output
Monitor/Controller window.

• Uncheck Disable Output in the Output Controller/Monitor window. The proof will 
be printed.
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Making Plates

Creating Files for Plates

• Use your DTP application to prepare separation output files - please refer to your
application manual for help.
Select an output page size sufficiently large to accommodate your content and any
registration marks or color bars - it should not be the same size as your plate. The
RIP will position a smaller page correctly on your plate for you.

• Save the file to a folder, either on the computer running Navigator RIP or on a
server.

Loading Plates on the PlateWriter

LOAD-position: The Plate Alignment Mat is moved out of the printer onto the
 Front Plate Table, where a plate can be loaded.
READY-position: The Plate Alignment Mat has moved the plate through the printer
 and the unit has detected the front edge of the plate.

The plate is ready to be printed.

• If Plate Alignment Mat is already
in LOAD-position the display (1)
will say "PLATE LOAD".

"
NOTE! If display says
"SHEET SET ERROR" 
move the Alignment Mat
slightly backwards by
pressing the Up [ ] key
for a few seconds, then
press the [EJECT PLATE]
key (2) and the Mat will
move to the LOAD-position.

• If Plate Alignment Mat is not in
LOAD-position, press [EJECT
PLATE] key (2).
This will move the mat to the
LOAD-position.

continues…
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• Place plate on the Plate
Alignment Mat (3) making sure
that it is placed up against the
round edge guides (4) and
that the front edge of the plate is
placed between the two front
edge alignment lines (5).

• Press [LOAD PLATE] key (6).
The Plate Alignment Mat moves
the plate to READY-position.

Imaging the Plate 

• In the Navigator RIP open the Output Controller / Monitor window by either
pressing Ctrl+O or choosing Output -> Output Controller from the RIP menu.

• Be sure that Disable Output is checked.

• Select File -> Print file from the RIP menu.
Choose an appropriate PlateWriter 4200 Page Setup that matches your print job and
the orientation of the loaded plate, then choose a file type (.ps, .pdf, .eps, .jpg or .tif).
Navigate to the folder containing your separation files, choose the files, and click on
Print.

• The files will be ripped and will appear in the Active Queue of the Output
Monitor/Controller window.

• The ink (colour) of each separation will be displayed in brackets after the job name,
and if there are multiple pages, then each page will be designated with a numeric
value.
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• Select your file and click on Info.

• The ThroughPut Info window appears.

• Be sure that Change all pages in job is checked.

• Click on Page layout... to open the Page Layout window.

• Check that the size of your plate is correctly entered in the Media Width [MW] and
Media Length [ML] boxes. If you have a Landscape press, and have loaded the plate 
Landscape on the Alignment Mat, then make sure to select the Center page on
Media Width and set the Top Margin [TM] to accommodate the normal unprintable 
area on your press (also known as the Grip).
If you have a Portrait press, and have loaded the plate Landscape on the Alignment
Mat, then make sure to select the Center page on Media Length and set the Left
Margin [LM] to accommodate the normal unprintable area on your press.

continues…
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• Click OK in the Page Layout window and in the ThroughPut Info window.

• Drag all but the first separation of your job to the Held Queue.

• Uncheck Disable Output in the Output Controller/Monitor window.
The first plate will be printed.

• Remove the plate from the PlateWriter and place it on the front of the PlateWriter
finishing unit - see finishing procedure in the following

• For subsequent plates, make sure that Disable Output is checked, load a plate into
the PlateWriter 4200, drag one separation from the Held Queue to the Active
Queue, and then uncheck Disable Output.

Pausing or Cancelling Printing

• Use the [PAUSE] key to stop or pause printing.
The printer stops, the light in the [PAUSE] key will light up and the following will
appear on the display:

How you should press the [PAUSE] key this time depends on whether you want to
cancel or resume printing:

If you wish to Cancel Printing

• Hold down the [PAUSE] key for one second or longer.
The following will appear on the screen....

...and printing is stopped.
Any remaining data is cleared.

If you wish to Resume Printing

• Press the [PAUSE] key again.
Printing or cutting is resumed.
The light in the [PAUSE] key turns off.
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Finishing

• Use +/- buttons on the Program
Selector (1) to select program:
1 = 0.15 mm plates
2 = 0.20 mm plates
3 = 0.30 mm plates
4 = Gumming only/Gum Rinse

"
NOTE! Program 0 is for
technicians only!

• Make sure that indicator (2)
lights steady green.

"
NOTE! For the various
indicator status and error
codes please see chapter 5
 "Trouble Shooting".

• Place the printed plate (3) on the
conveyor making sure that the
front edge is placed over the
plate sensor (4).

• If the curing oven has already
reached the correct working
temperature, the conveyor will
take the plate through the oven,
otherwise it moves the plate
slightly forward and then it stops
until oven is ready.

• The indicator (5) will start to
flash indicating that the unit is
busy.
Do not insert another plate while
indicator is flashing.

• When finished the plate is
placed on the exit tray (6).

Operating Manual - PlateWriter
TM

 4200 0648

Daily Use
2-9

Making Plates

1

2

3
5

4

6



Daily Shut-Down

• Switch the unit into OFF-mode
by pressing and holding the
[POWER] key (1) for 2 secs.
All lights turn off and the display
(2) will go blank.

"
NOTE! When in OFF-mode
the unit will still "wake up"
at intervals and perform
the maintenance cycle and
then automatically return
to
OFF-mode.

Important notes about switching the Power On and Off

Never switch off the main power while the sub power is switched on. The printing
heads may be left uncapped (the printing carriage may remain over the Plate
Alignment Mat). If the machine is left unused with the printing heads uncapped for a
prolonged period, the printing heads may become irreversibly clogged.

Before switching off the main power, be sure to hold down the [POWER] key for one
second or longer to switch off the sub power.
If the printing carriage stops while over the platen, press the [POWER] key to reset the
power. The printing carriage moves and the printing heads are capped.
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Part 3: Cleaning & Maintenance

Overview

This section describes the various procedures for care and maintenance such as:

Printer

• Positioning of the Plate Alignment Mat

• Setting the Image Origin Point

• Replacing of Ink Cartridges

• Cleaning of Printing Heads

• Cleaning of Body, Alignment Mat etc.

• Replacing of the Wiper

• Replacing of the Flushing Pad

• Disposing of discharged Ink

Finishing Unit

• Replacing the Gum/Finisher Solution (Daily)

• Running the Gum Rinse Program (Weekly)

• Cleaning of the Gum/Finisher Rollers (Monthly)
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How to Power Up the PlateWriter in Service Mode

Some procedures require the use of various functions which are only available from
the PlateWriter's Service Mode.

To Power Up the PlateWriter in Service Mode do the following:

• The PlateWriter's main power button must be switched ON and the sub-power must 
be switched OFF.

• First press the following sequence of keys:
Up [ ] - Left [ ] - Right [ ] - Down [ ] - Left [ ] - Down [ ] - Right [ ]. 
Then press and hold the Left [ ], Down [ ], and Right [ ] keys while pressing the 
sub-power [ ] key.

$
IMPORTANT! After performing a procedure requiring for the PlateWriter to
be in Service Mode make sure to switch the printer off and then back on in
normal operating mode.  
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Installing the Plate Alignment Mat

Positioning the Pinch Rollers

• Disengage the Pressure Lever (1) located to the left of the Front Plate Table.
To disengage the lever pull it outwards and upwards.

• Right Pinch Roller (2):
Move to the far right position.

• Left Pinch Roller (3):
First move to the far left position, then move it slightly to the right (approx. 1 mm).
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Positioning the Plate Alignment Mat

• Place the Plate Alignment Mat (1) on the Front Plate Table (2).

• Slide the mat through the printer underneath the Pinch Rollers (3) until the edge of
the mat is about 25 mm (1") behind the front edge of the Front Plate Table (2).
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• Locate the Registration Pins (4) from the Installation Toolbox.
Insert a pin into the far left hole of the first line of holes in the vacuum bed as shown
and another pin into the far right hole.

"
NOTE! Always keep the Registration Pins in a safe place. It is not possible
to align the Plate Alignment Mat properly without them.

• Slide the Plate Alignment Mat (1) backwards up to the Registration Pins (4) so that
the slots in the mat register with the pins as shown.
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• Now first engage the Pressure Lever (5) and then remove the Registration Pins (4).
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Setting the Image Origin Point

General

Each printer is unique and after loading the Alignment Mat for the first time, you must 
calibrate the PlateWriter in relation to the Alignment Mat installed.
This allows the PlateWriter to determine the exact origin of each plate loaded onto
your Alignment Mat ensuring accurate imaging for each plate loaded and excellent
registration on press.
This is done by performing a calibration print on which the result is measured to
update the PlateWriter settings to the correct values.

Loading the Media at the Current Print Origin Position

• Power up the PlateWriter in Service Mode as described earlier in this chapter.

• When display says "PLATE LOAD" press the [EJECT PLATE] key to move the
Alignment Mat (3) to the plate load position.

• Align a plate (1) with the edge guides (2) on the Alignment Mat (3) and make sure
that the front edge of the plate is placed between the two front edge alignment lines
(4).

• Press [LOAD PLATE] key to move the Alignment Mat (3) to the current origin point.
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Printing the Align Plate Test Pattern

• On the RIP workstation locate the PlateWriter Utility icon and double-click it to
launch the application.

• Select the Setup tab.

Set Channels to Black.
In the Margins section set values for both Top and Left margins to 0.

"
NOTE! The "Eject media" in the "Media control" section will not operate
when working in Service Mode 

• Select the Test print tab.

From the Test job drop-down menu select the job Align Plate.TIFF
Ensure that in the Nozzletest section the Print before job, left margin and the Print
after job, left margin check boxes are not checked.
Make sure that Testjob is set to None in the Automatic testjobs section.
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• Click Print.

• The image shown below will be printed on the plate.

• When printing has finished, press the [EJECT PLATE] key on the control panel to 
eject the plate.

Operating Manual - PlateWriter
TM

 4200 0648

Cleaning & Maintenance
3-9

Setting the Image Origin Point



Adjusting the Left Offset and Frame Back Values

Determining the Left Offset

• Initially we will consider the Left Offset, which is the distance between the left edge
of the plate and the start of the image, which should go right up to the edge of the
plate.

• Examine the position of the image on the printed plate.

• The correct image position is as illustrated to the left where the black squares just
touch the edge of the plate and an small gap is just visible between the 0.2 mm line
and the plate edge.
– If there is  a space between the black squares and the left plate edge, then the Left

Offset on the printer must be reduced - measure the space to determine the value
by which the offset must be reduced.

– If the black squares print off the edge of the plate and on to the Alignment Mat,
the Left Offset should be increased - use the ruler indication lines to determine
the value by which the offset must be increased.

• Write down the value as you will need it when adjusting the PlateWriter as
described in the following.

Adjusting the Left Offset Value

• Press [MENU] key to enter the menu.

• Press the Right [ ] key to enter the SERVICE MENU.

• Press the Up [ ] key to scroll to the LEFT OFFSET item.

• Press the Right [ ] key to enter the LEFT OFFSET function.
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• The current value for the Left Offset will be displayed to the left and the new setting
will be displayed to the right.
Use the Up [ ] or Down [ ] keys on the control panel to adjust the value as
required.
E.g. if the test image started 2 mm in from the edge of the plate, reduce the current
Left Offset value by 2 mm.
When the correct value is displayed press the [ENTER] key.

Determining the Frame Back Offset (Lead Edge Offset)

$
IMPORTANT! Adjusting of the Frame Back Offset works in an opposite way
to the Left Offset as described earlier.

• Now we will consider the Frame Back, which is the distance between the leading
edge of the plate and the start of the image, which should go right up to the edge of
the plate.

• Examine the position of the image on the printed plate.

• The correct image position is as illustrated to the left where the black squares just
touch the edge of the plate and an small gap is just visible between the 0.2 mm line
and the plate edge.
– If there is  a space between the black squares and the leading plate edge, then the

Frame Back on the printer must be increased - measure the space to determine the 
value by which the offset must be increased.

– If the black squares print off the edge of the plate and on to the Alignment Mat,
the Left Offset should be reduced - use the ruler indication lines to determine the
value by which the offset must be reduced. 

• Write down the value as you will need it when adjusting the PlateWriter as
described in the following.
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Adjusting the Frame Back Offset Value

• Again press [MENU] key to enter the menu, press the Right [ ] key to enter the
SERVICE MENU and use the Up [ ] key to scroll to the FRAME BACK item.

• Press the Right [ ] key to enter the FRAME BACK function.

• Press the Right [ ] key to enter the SET VALUE function.

The current value for the Frame Back will be displayed to the left and the new
setting will be displayed to the right.

• Use the Up [ ] or Down [ ] keys on the control panel to adjust the value as
required.
E.g. if the test image started 2 mm in from the edge of the plate, increase the current
Frame Back value by 2 mm.
When the correct value is displayed press the [ENTER] key to update the values,
then press the [MENU] key to exit the SERVICE MENU.

Confirming Offset Values

• Now load another plate (or turn current plate quarter of a turn) and reprint the
Align Plate.Tiff test pattern to confirm that you have set the offset values correctly.

• Repeat the process as described above until you are satisfied with the origin of the
image in relation to the plate's left and leading edges.

• Finally select the Setup tab in the PlateWriter Utility window and set Top margin to 
5 mm and Left margin to 10 mm. 
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Bidirectional Correction

This adjusts for misalignment that occurs during bidirectional printing. You should
perform adjustment for bidirectional correction whenever media is replaced by a
different type or when using the machine in a location subject to large changes in
temperature. 

"
Bidirectional correction is enabled only when performing bidirectional
printing.

Setting the adjustment value

"
To obtain correct results, load a plate of the same thickness as those used on
press.

1 Press the [MENU] key, then press the Down [ ] key to select [ADJUST BI-DIR]. 

2 Press the Right [ ] key, the screen shown below appears.

3 Press the [ENTER] key. A test pattern is printed. After the printing test is finished,
the media is fed to a position that lets you view the test pattern.

4 Check the test pattern and select the adjustment value. i.e. a value that does not
produce any displacement.
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5 Check the adjustment value, then press the [ENTER] key. the media returns to its
position where the printing test ended.

6 Press the Down [ ] key to select [SETTING NO. 1]. You can select from [SETTING
NO. 1] through [SETTING NO. 4].

7 Press the Right [ ] key, the screen shown below appears.

8 Use the Left [ ] and Right [ ] keys to select H1 or H2. Use the Up [ ] and Down
[ ] keys to set the value you checked in step 4. When you have entered all the
adjustment values, press sthe [ENTER] key. The adjustment values are changed.

9 Repeat steps 6 through 8 to enter adjustment values for [SETTING NO.2] through
[SETTING NO. 4].
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Saving and loading a bidirectional correction value

You can save up to eight patterns of adjustment values for bidirectional correction that
you've set in memory. Saving different adjustment values for different types of media
lets you load the adjustment value simply and easily when you change the media type.

Saving an adjustment value

1 Follow the steps in the previous section, “Setting the adjustment value,” to enter
adjustment values.

2 Press the Down [ ] key to select [SAVE PRESETTING].

3 Press the Right [ ] key to display the screen shown below. Select a memory to save 
to from among [PRESETTING 1] through [PRESETTING 8], then press the [ENTER] 
key. The adjustment values are saved in the memory number you selected.

"
It may be a good idea to keep notes of the memory numbers and the kind of
media whose adjustment value is saved in each number.

Loading an Adjustment Value

"
This operation deletes adjustment values that are not saved in memory. If
there are adjustment values that you want to keep, save them in memory first.

1 Press the [MENU] key, then press the Down [ ] key  to select [ADJUST BI-DIR].

2 Press the Right [ ] key. the screen shown below appears.
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3 Press the Down [ ] key to select [SAVE PRESETTING].

4 Press the Right [ ] key to display the screen shown below. Select the memory
number to load, then press the [ENTER] key. The selected adjustment value is
loaded.
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Inks and Fluids

The PlateWriter requires the use of various inks and fluids for processing, cleaning and 
maintenance purposges:

Liquid DotTM (1)

The Liquid DotTM ink is supplied in special cartridges and used in the imaging channels 
to create a hydrophobic image on the printing plate.

Maintenance Fluid (2)

The Maintenance Fluid is a general purpose fluid supplied in special cartridges, and is
used to keep the unused printheads available for use as backups.
It can also be used as a light cleaning fluid.

Cleaning Fluid (3)

The Cleaning Fluid is supplied in a small bottle, and is used together with a cleaning
stick to wipe around the printheads and wiper blades to removed dried ink and dirt.
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WARNING!
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• HARMFUL IF INHALED.

• MAY BE HARMFUL IF SWALLOWED OR ABSORBED THROUGH SKIN.
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For additional information, please see Material Safety Data Sheet (MSDS).
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  before reuse. Thoroughly clean shoes before reuse. Get medical attention if
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the direction of the arrow.

WARNING!

CONTAINS       1- Methoxy - 2 - Propanol      107 - 98 - 2

                                  

FIRST AID
• If inhaled, r

• FLAMMABLE LIQUID AND VAPOUR.

• HARMFUL IF INHALED.

• MAY BE HARMFUL IF SWALLOWED OR ABSORBED THROUGH SKIN.

• MAY CAUSE IRRITATION TO SKIN, EYES, AND RESPIRATORY TRACT.

Ammonia                                    1336 - 21 - 6

For additional information, please see Material Safety Data Sheet (MSDS).
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   If breathing is difficult, give oxygen. Get medical attention.

• In case of contact,  immediately flush skin with plenty of water for at least 15

  minutes while removing contaminated clothing and shoes. Wash clothing

  before reuse. Thoroughly clean shoes before reuse. Get medical attention if

  symptoms occur.
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Replacing the Ink Cartridges

If ink runs out replace the cartridges as described in the following.

$
CAUTION! Never use any ink other than genuine Liquid Dot ink from
Glunz & Jensen. Doing so may result in malfunction or faulty operation.

Care and Handling of Ink Cartridges

Give attention to the following points when handling ink cartridges.

• Never attempt to install any ink other than a Liquid Dot cartridge.

• Never attempt to disassemble.

• Never drop or allow to fall. The impact from a fall may cause damage, making the
cartridge unusable.

• Store unopened in a well-ventilated location where the temperature is from -20ºC
(-40ºF) to 40ºC (104ºF).

• Once an ink cartridge has been installed, never remove it until the ink has been used 
up, except when moving the machine.
Frequent insertion and removal may cause air to enter the ink tube, resulting in dot
drop-out or other problems in printing quality.

• Always be sure to gently shake the ink cartridge before you install it.

• Removing or inserting an ink cartridge while operation is in progress may cause air
to get inside the cartridge, resulting in poor image quality.

• After removing an ink cartridge, never allow the machine to stand with the
ink-cartridge port remaining empty — install a new ink cartridge immediately.
Failure to do so may result in clogging of the heads.
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If Ink runs out during Printing

• If ink runs out during printing, a warning beep sounds and the following appears on 
the display:

The empty cartridge number and "_" will flash (in this case cartridge 1).

• Replace the ink cartridge indicated by the flashing number on the display as
described below.

$
CAUTION! Ignoring the message and continuing printing without replacing
the ink may adversely affect image quality, resulting in faintness or other
problems.

Replacing an Ink Cartridge

Before attempting to replace an ink cartridge make sure that the Imaging Unit is
switched on and that operation has been stopped or paused.

• Gently shake the new cartridge
(1).

• Pull out the empty cartridge then
immediately insert the new one
slowly and firmly as far as it will
go.

"
NOTE! Remove the
cartridge gently. Sudden
movement when removing
may cause ink to be spilled.
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Checking the State of the Printing Heads

Problems such as missing dots may reduce the printing quality.
To test the state of the printing heads do the following:

• Load a plate for printing-test use.

• Press and hold the [TEST PRINT]
key for at least one second.
The test pattern is printed.

• If the test result shows drop-outs,
carry out head cleaning to restore
the heads to their proper state.
See “Cleaning the Printing Heads."
below for details.

Cleaning the Printing Heads

"
NOTE! Only perform head cleaning when there is dot drop-out (gaps) or
printing becomes faint.
Switching on the sub power automatically performs maintenance operations,
including cleaning of the printing heads, meaning that there is normally no
need to perform cleaning otherwise.

To perform cleaning do the following:

• Load a plate for printing-test use.

• Hold down the [CLEANING] key for at least one second.
Cleaning of printing heads starts.

• After head cleaning has ended, print the test pattern as described in “Checking the
State of the Printing Heads" above.

• Examine the test pattern and if a problem is found, repeat the cleaning.

If performing cleaning several times does not correct the image drop-out problem,
perform head cleaning by selecting the [HEAD CLEANING] menu from the main
menu.
For more information, refer to “If Drop-out Persists After Cleaning Several Times" later 
in this chapter.

Important notes about Cleaning of Printing Heads

Performing head cleaning more than necessary subjects the heads to wear and
consumes ink.
In particular, cleaning performed using the [POWERFUL] menu setting for [HEAD
CLEANING] can cause premature head wear and consume large amounts of ink
(performing cleaning at the [POWERFUL] setting consumes approximately 30 cc of ink 
for all ink cartridges.)
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If Drop-out Persists After Cleaning Several Times

If drop-outs persists even after carrying out printing head cleaning several times,
follow procedure below to perform head cleaning:

• Load a plate for printing-test use.

• Press the [MENU] key, then use [ ] or [ ] key to scroll to the [HEAD CLEANING]
item.

• Press the [ ] key to enter the [HEAD CLEANING] function, the use the [ ] key to
select [POWERFUL] or [MEDIUM].

• Press the [ENTER] key.
Head cleaning starts.

• When head cleaning finishes perform a printing test and check the result - see
“Checking the State of the Printing Heads" earlier in this chapter details.

If performing cleaning several times at the [POWERFUL] setting does not correct the
image drop-out problem, then clean the printing heads using the cleaning kit.
See “Cleaning Using the Cleaning Kit" later in this chapter for details.
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Cleaning Using the Cleaning Kit

General

Cleaning using the cleaning kit should be carried out when automatic cleaning and
forced cleaning performed using the [HEAD CLEANING] function fail to correct
image drop-out. It removes any ink buildup and accumulated dust or grime from
around the printing heads, as these can cause image drop-out or ink drips.
We also recommend performing periodic cleaning using the cleaning kit to prevent
problems like these during printing.
If image drop-out persists even after performing cleaning with the cleaning kit, or if
the cleaning kit has been used up, contact your authorized Glunz & Jensen dealer or
Glunz & Jensen Customer Support.
The heads are consumable parts. The useful life is six billion shots per nozzle.

Tools

• Cleaning Fluid

• Cleaning Sticks

Before Starting Cleaning

Before you start the cleaning, read through this section carefully to familiarize yourself
with the procedures, then carry out the cleaning operations quickly and accurately.
Cleaning is performed while the caps on the printing heads are detached, so cleaning
must be completed before the heads dry out.
It is suggested that cleaning should be completed in 30 minutes or less.
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Cleaning Preparations

• Make sure that the Imaging Unit is completely shut-down, meaning that it has been
switched off on the [POWER] key and then on the main power switch on the rear
right side of the unit.

• Now switch on the main power switch.

• While pressing and holding down the [CLEANING] key, press the [POWER] key.
The following will appear on the display:

• Press the [ENTER] key.
The display will show:

• Remove the screws (1) and detach
the maintenance cover (2).

• Press the [ENTER] key.
The printing carriage (3) moves
to the cleaning position and the
display will show:

continues…
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• Remove the two screws (4).
Lift the cover (5) up and then
remove it.

• To discharge static electricity
from your body, touch the
location shown.

Cleaning

• Use a cleaning stick (1) to clean
the nozzle surfaces (2) of the
heads. Wipe off any grime from
the head's stainless-steel frame
(3) and the plastic areas (4) on
either side of the heads.

$
CAUTION! Never touch
the nozzle surface of the
printing heads with your
fingers.
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• Use the cleaning stick to
wipe away any build-up of dust
and ink from the stainless-steel
frame (5) around the flushing
pad.

• Use the cleaning stick to remove
any build-up of dust or grime
from the rubber caps (6) and the
area around them.
If dust is present on the sponges
(7), wipe it off as well.

$
CAUTION! If no grime is present, never touch the sponges inside the rubber
caps. When removing grime adhering to the sponge inside a rubber cap, touch
the sponge gently with the tip of the cleaning stick to pick up the grime.

Rubbing forcefully may damage the surface of the sponge.

continues…
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• Use the [ ] key to extract the
wiper (8), then use a cleaning
stick to wipe away any build-up
of dust and grime from the wiper.

"
NOTE! If the message [REPLACE WIPER] appears on the display, replace the
wiper with a new one. As a rule of thumb, the message prompting you to
replace the wiper appears when cleaning has been performed 1500 times (with
[ALL] selected for head cleaning).
For information on how to replace the wiper, see “Replacing the Wiper" later
in this chapter.

• Attach the cover (9) with the
screws (10) making sure that it
engages the hooks (11).

• Press the [ENTER] key.
The printing carriage returns to
the standby position and head
cleaning starts automatically.
The display will show:
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• When this display appears

attach the maintenance cover (12)
using the screws (13).

• Press the [ENTER] key. The sub power will be switched off.

• Press the [POWER] key to switch on the sub power.

• Make a test print as described in "Checking the State of the Printing Heads" earlier in 
this chapter.
Examine the result of the test print and make sure that all dots are printed properly.
If necessary, perform head cleaning to make the dots clean and even.
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Other Printer Cleaning Tasks

General

Exposed areas of the machine may become soiled with ink during printing.
The cleaning methods described below let you continue printing without affecting the
printed media or the machine.

"
NOTE! When carrying out any cleaning other than cleaning using cleaning
sticks, switch off the main power (before turning off the main power, press the 
[POWER] key to switch off the sub power.)
Never lubricate the mechanisms.
Never clean with solvents (such as benzine or thinners).
Periodically clean the Alignment Mat.
Never touch the printing heads or allow the printing heads to come in contact
with anything except ink.

Cleaning the Printer Body

Use a cloth moistened with water then wrung well, and wipe gently to clean all
surfaces.
Wipe the operation panel and display gently with a clean, soft cloth.

Cleaning the Alignment Mat

Moisten a cloth with neutral detergent diluted with water, wring dry, and wipe gently.

"
NOTE! If removing the Alignment Mat for cleaning it must be reinstalled as
described in the "Hardware Installation Manual".
Also it is very important that the mat is totally dry when installed.

Cleaning the Grit Rollers

Use a commercially available brush to remove dust and other detritus.
Any adhering grime may prevent the media from being held in place securely.

Cleaning the Pinch Rollers

Moisten a cloth with neutral detergent diluted with water, wring dry, and wipe gently.
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Replacing the Wiper

When the following message appears on the display:

you should replace the wiper with a new one following description below.

• Make sure that the Imaging Unit is completely shut-down, meaning that it has been
switched off on the [POWER] key and then on the main power switch on the rear
right side of the unit.

• Now switch on the main power switch.

• While pressing and holding down the [CLEANING] key, press the [POWER] key.
The following will appear on the display:

• Remove the two screws (1).
Lift the cover (2) up and then
remove it.

• To discharge static electricity
from your body, touch the
location shown.

continues…
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• Use a cleaning stick or the like as
stopper (3) and insert in the
groove (4) as shown.
Make sure the display says:

• Press the [ENTER] key.
The wiper (5) moves.

• Using tweezers, grasp the
bottom portion of the wiper and
take it off the hook (6).

• Remove the wiper and install the
new one.
Make sure that the rubber surface
(7) faces the front and the felt
surface (8) faces the back.
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• Using tweezers, grasp the
bottom portion of the wiper and
engage it on the hook (6).

$
CAUTION! If the wiper is
not hooked, it may fall off
during operation.

• When the display says

remove the stopper (10).

• Attach the cover (11) with the
screws (12) making sure that it
engages the hooks (13).

• Press the [ENTER] key.
The printing carriage returns to
the standby position and head
cleaning starts automatically.
The display will show:

• When cleaning has finished, press the [POWER] key to switch off the sub power.

• Again press the [POWER] key to switch on the sub power.

• Make a test print as described in "Checking the State of the Printing Heads" earlier in 
this chapter.
Examine the result of the test print and make sure that all dots are printed properly.
If necessary, perform head cleaning to make the dots clean and even.
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Replacing the Flushing Pad

The Flushing Pad should be replaced when ink build-up becomes to distinct.
Follow description below to replace the Flushing Pad.

• Make sure that the Imaging Unit is completely shut-down, meaning that it has been
switched off on the [POWER] key and then on the main power switch on the rear
right side of the unit.

• Now switch on the main power switch.

• While pressing and holding down the [CLEANING] key, press the [POWER] key.
The following will appear on the display:

Press the [ENTER] key.

• Remove the two screws (1).
Lift the cover (2) up and then
remove it.

• To discharge static electricity
from your body, touch the
location shown.
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• Remove the screw (3) then
remove the wiper cover (4).

• Use a small, flat screw driver to
remove the flushing pad cover (5).

• Replace the Flushing Pad (6) with
a new one.

• Mount flushing pad cover and
wiper cover in the reverse order.

continues…
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• Attach the cover (7) with the
screws (8) making sure that it
engages the hooks (9).

• Press the [ENTER] key.
The printing carriage returns to
the standby position and head
cleaning starts automatically.
The display will show:

• When cleaning has finished, press the [POWER] key to switch off the sub power.

• Again press the [POWER] key to switch on the sub power.

• Make a test print as described in "Checking the State of the Printing Heads" earlier in 
this chapter.
Examine the result of the test print and make sure that all dots are printed properly.
If necessary, perform head cleaning to make the dots clean and even.
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Replacing the Sponge

When the following message appears on the display:

you should replace the sponge with a new one following the description below.

• Make sure that the Imaging Unit is completely shut-down, meaning that it has been
switched off on the [POWER] key and then on the main power switch on the right
side of the unit.

• Remove the two screws (1).
Lift the cover (2) up and then
remove it.

• Remove the screw (3) then pull
out the discharged ink tray (4).

• Remove the sponge (5) and
replace it with a new one.

continues…
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• Secure the discharged ink tray
then attach the cover (6) with
the screws (7) making sure that
it engages the hooks (8).

• Switch on the main power and
the sub power.
The display will show:

• Press [ENTER] key to confirm
that sponge has been replaced.
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Disposing of Discharged Ink

$
CAUTION! Discharged ink is flammable and contains toxic ingredients.
Never attempt to incinerate discharged ink or discard it with ordinary trash.
Also, never dispose of it in sewer systems, rivers, or streams. Doing so may
have an adverse impact on the environment.

Dispose of ink in the drain bottle as described below:

• Press and hold the [POWER] key
for at least one second to switch
off the sub power.

• Remove the full drain bottle (1)
and replace it with an empty
one (2).

• If you have no replacement bottle
insert plug (3) while emptying
the bottle.

• Dispose of discharged ink
properly and in accordance with
local laws and restrictions.

"
NOTE! If any ink gets on your hands or clothing, wash it off as soon as
possible. Ink stains may become difficult to remove if allowed to stand.
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Finishing Unit

Running the Gum Rinse Program

"
NOTE! It is recommended to run the Gum Rinse Program a the end of each
working period (preferably once a week).

• Replace the solution in the  Gum/Finisher bottle with warm water.

• Select Program 4 on the Program Selector to start the Gum Rinse Program.

• The unit will run for app. 10 min. recirculating the water through the gumming
system and then it switches to stand-by mode.

• Leave the unit with water until the start of the next working period, then replace the
water with fresh Gum/Finisher Solution.

#
Warning!: Danger of crushed fingers when working inside the Finisher
section, proceed with caution. Always replace the side plate after completing
cleaning and maintenance tasks in the Finisher section.

$
Caution!: Always replace the side plate after cleaning and maintenance of the
Finisher section. Failure to do this will result in inferior processing quality. 

Procedure for accessing the Gum/Finisher section

See figure opposite

• Turn off the power supply to the machine.

• Remove the plug from the socket. 

• Lift the side plate by its knob and push it into the recess where it can be stored while 
working in the section. 

You can also remove the covers of the curing oven and gum dryer for easier access
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Cleaning of Gum/Finisher Rollers

"
NOTE! It is recommended to perform this cleaning procedure monthly.

(See illustration opposite)

• Switch off and unplug the Finisher Unit.

• Remove the Gum Dryer (1).

• Remove the Gum Section Cover (2).

• Take out the roller (3).

• Release the roller bearings (4) and take out the rollers (5) and (6).
To release the roller bearings press the locking arm as illustrated and then pull
upwards.

• Clean the rollers and bearings in hot water using a soft brush.

• Reinstall all parts in reverse order, making sure that the bearings (4) click properly
into place.

Cleaning the Finishing Unit Body

Use a cloth moistened with water then wrung well, and wipe gently to clean all
surfaces and conveyor belts.
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Gum/water Replenishing System

Use

• Depending on the size of the plate, the finishing unit sets aside a little water pump
run time (approximately 1 s for every 60 seconds that the finishing unit is running).
Once the plate has passed through the machine, the water pump replenishes the
reserved amount of water and distributes it to clean the rollers. 

• If plates are continuously running through the finishing unit, it will continue
reserving water replenish until it has accumulated 30 seconds. The finishing unit
lights green (ready) as soon as water replenish is added.

"
Do not turn off the finishing unit before it is ready (green). This ensures that
water replenish is added and will stop the rollers from sticking together the
next day. 

• If the finishing unit is turned off before replenish has been added, any saved
replenish will be deleted. 

• The water tank (1) must be placed below the gum bottle with the cap in the tray
dismounted. The water tank functions as a drip tray for the gum bottle.

Cleaning

• The water tank must be emptied and cleaned once a week, for instance when
changing gum. 

• Refill with demineralised water only to avoid contamination of gum/plates.

• With the gum/water replenish system installed, gum should only be
changed/refilled and cleaned once a week.

Gum consumption will be approximately 20 g/m².

Water consumption will be approximately 40 g/m².

"
Depending on the throughput in the finishing unit, you should calculate how
much gum and water to put in the gum bottle and water tank to make the gum
last one week. If there is less than 25% gum remaining in the bottle when
commencing work with the printer in the morning, it is a good idea to top up. 
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Part 4: Using the RIP

Overview of the Navigator RIP

The Navigator RIP is an application that takes a document or job describing images or
pages and produces output from that job on an output device - which in this case is
either the PlateWriter 4200 or a proofing device.
In general, a software application or hardware device that performs this task is known as 
a Raster Image Processor (RIP) or, where the PostScript® language is involved, a
PostScript-language compatible interpreter.

The iCtP RIP workstation is not just a Navigator RIP, it is a RIP management system.
It contains both a RIP and a collection of supporting functions that help the RIP
perform its task effi ciently.
For example, the iCtP Workstation accepts jobs from various platforms such as Mac or
PC, different sources (from disks, CD’s, shared folders on Networks or virtual printers
visible to other users), the iCtP RIP Workstation also handles previewing and output of 
processed pages, and performs the associated file handling.

Input formats

The Navigator RIP accepts jobs from most major graphics applications and supports
the following formats, with the exact options depending on your configuration of the
RIP.

The input formats includes: 

• PostScript-language (PS) files

• Encapsulated PostScript (EPS) files

• Portable Document Format (PDF) files

• TIFF/IT-P 1 files

• (16-bit) TIFF 6.0 baseline files

• JPEG and JFIF files

The Navigator RIP supports modern versions of these files including PostScript
Language Level 3, PDF version 1.5, and derived standards such as PDF/X.
The RIP also has controls for special handling of older versions of these files if
necessary.
The Navigator RIP can produce output in a variety of formats, to suit various physical
output devices and file formats.
Similarly, there are options for output to many proofing printers and final output
devices. Each device, may have certain size limitations, as well as the ability to handle
colour (for proofing) or separations (for PlateMaking).
And in turn each of these devices will have its own gain characteristic and require
calibration.

continues…
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Once the RIP is installed, a one-of set up is required to create a "base" from which the
RIP will operate, and from time to time you may find it necessary to update or modify
the settings to suit your ever changing requirements.
As there is a great deal to set up, Glunz & Jensen has created the config.ps file (found
in the C:\Program Files\Xitron Navigator7.0r3\Factory Defaults folder).
The file contains a "Basic Set-up" covering all the settings and calibrations required for
several Plate sizes and can be loaded in to the RIP upon start-up.
Printing the config.ps file installs all the items required for an initial set up of the RIP
including setting memory allocation, the RIP mode, Buffers as well as some default
Calibrations, Tone Curves, and Page Setups for PlateMaking.
Once these have been loaded and the RIP restarted, (and your unlock codes entered as
described in the previous section) you can use the following procedures outlined in
this section to assist you in editing the existing setups, duplicating them for the basis of 
new setups or creating new page setups and calibrations customized for your press.

Basic Concepts and Definitions

This section is intended as a guide to cover the basics required for operating the
Navigator RIP and to get you started.
For a much more detailed explanation of the RIP or each of these definitions please
consult the separate RIP User Manual located in your Manuals folder in the main RIP
folder.
Many of the main functions and items referred to in this chapter are briefly described
below:

• Devices: are essentially combinations of a physical printer, a software screen
method, and printer-to-computer connection (i.e. USB).

• Separation Styles: have to do with how separations and composite files are handled
by the Navigator RIP. You can use a “Composite” style to print composite or
pre-separated files, a “Separations” style to separate composite files in the RIP
(including limited trapping), and a “Progressive” style to produce progressive
proofs from composite files.

• Page Setups: are sets of information required for printing a plate, including, a
Device, the Resolution, a Media Size, Calibration and Tone Curves, margins on the
Media, Rotation, etc.

• Media Size: when making a Page Setup this will be the size of your printing plate
OR the size of the paper used for making proofs.

• Page Size: is the size of the PostScript or .pdf file that is sent from your pre-press
application. When you create or edit a Page Setup, the default Page Size is arbitrary.
The RIP will override that setting with the size of the file you send to the Navigator
RIP.

• Calibration Curves: are used to linearize the output of your Plate or proofer and to
add tone curves to your output.
Printing config.ps installs: iCtP Linear which is a Calibration Curve for Plate

Writer-4200 using Glunz & Jensen i-plates.

For proofing we have enabled the RIP to support Epson 4000 and Epson 7600

printers, within the Config dialogue box for each proofing device are several built-in

calibration curves (shown in with Green ticks) for various Epson papers and inks.
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• Actual Press Curves: are used to Linearize dot gain from the printing press, or to
emulate the characteristics of another press.
Printing config.ps installs: PressLinear 18, Heidelberg PM 46 – Coated, Hamada
A252 - Coated (plus others) which are Press Calibration Curves for Linearising

Glunz & Jensen i-plates on most commercial printing presses.

Please note that these are default curves, to achieve a more accurate calibration, you

may wish to create your own curves.

• Intended Press Curves: are used build back in the desired dot gain from the printing 
press, or to emulate the characteristics of another press.
Printing config.ps installs Industry standard: Commercial A,  SWOP and Fogra
curves, 15%, 20% & 22% gain curves (plus others) which are Calibration Curves
used to take the Linearised Glunz & Jensen -plates where 10% will print as 10% ,
30% as 30% and 50% as 50% and so on… which to many users (specially with 4
colour work) will create flat looking images.
The intended Press curves, ADD back the gain achieved with conventional halftones 
(such as produced by plates made by film) on most commercial printing presses.
Please note that these are default curves, to achieve a more accurate calibration, you
may wish to create your own curves.

• Tone Curves: are used to adjust dot gain further (they can be used to create a cooler
looking image, or to create more saturated images).
No Curves are installed with the config.ps, these can be generated by the user.
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Setting Up Devices

• Be sure that the PlateWriter 4200 is on and connected to your computer.

• Start the Navigator RIP and select NavigatorRIP -> Device Manager from the
application menu.

• Ensure the PlateWriter4200 appears in the Window. If it does not, then check that
you have entered the password for the PlateWriter4200 correctly (in the Navigator-> 
ConfigureRIP -> Extras dialogue box - when revisiting the ConfigureRIP -> Extras
Window, the device Platewriter4200 should have the word YES next to it if the
password entered was correct).

• The Device Manager window lists the device types that are available for the
PlateWriter Plugin, PlateWriter.i32. The iCTP PlateWriter4200 is the default name
for the PlateWriter Output device and only one option is available here.
This window gives you the ability to duplicate or rename the device or add other
devices supported by the plugin.
Based on our work with the PlateWriter 4200 and the Navigator RIP, we strongly
recommend to leave this unchanged (whilst not needing to change this device, you
may need to use this window to add proofing items under the iCTP plug-in).

Creating Separation and Progressive Styles

Separation Styles

A Separations Style is a definition used by the RIP to characterize how a file arriving
will be handled, how the colours will be separated out and what screening will be
used. There are many type of work flows used in the Print environment to send files to 
bureaus and to CTP equipment, one of the most popular is a Pre-Separated workflow
where users output their jobs in separations directly from the application, there are
others where users prefer to send composite jobs and allow the RIP to handle the
separations, in addition there are circumstances where files arrive in a format where
the incorrect colours have been used and you may desire the RIP to override the
separations.
A more extensive explanation is found in Chapter 14 of the Xitron RIP Manual that is
located in your Manuals Folder in the RIP Installation folder.
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Pre-defined Separations Styles

To make things easier, if you printed the config.ps file as described earlier, then it
would have already installed some separations styles for you.

• Select Colour -> Separations Manager from the NavigatorRIP menu.

• This opens the Separations Manager window. Select iCTP PlateWriter4200 as the
device.

The pre-defined Separation Styles appear in the list. They should cover all the
separation styles you need, so to create or edit a Page Setup, turn to the section
titled Creating Page Setups for Plate Making later in this section.
However if you did not print the config.ps file, follow the procedure as described
below to create your own Separation Styles.

Creating Separation Styles

• When opening the Separations Manager window there will be a CMYK Separations
style a Monochrome style already entered.

Click on New.
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• The New Style... window opens.

• Name the new style something that will be easy to remember and reflects what your 
separation style will achieve (e.g. SEPS (CMYK+Spot) to DEEDs2).

• Set Color space to CMYK.

• Set Output format to Separations.

• Click Create to open the Edit Style dialog.

• Choose which process colors you want to print using the pop-up list.
We recommend using Not Blank rather than Yes or No. Not Blank means that the
separation will be produced only if it is found in the composite .ps or .pdf file.
If you select Yes, all separations will be produced, even if they are blank. If you want 
SPOT colours to be printed, then set Other colours in job to Yes or Not Blank as
well.
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• If you received jobs such as PDF’s from customers that contain multiple Spot and
CMYK colours, and you want to force the separation to CMYK, then create an
additional Separation style, set C, M, Y & K to Yes, then Other Colours in job to No.

• Select whether to reject or recombine pre-separated jobs. Pre-separated jobs may
only be recombined if the separations come to the Navigator RIP in a single file.

• Now set the screen to be applied to the image. Set the Dot shape to DEEDS2PW,
this is the Dynamically Even – Extended Diffused Screens that have been designed
specifically for the PlateWriter.

• Check the Generate extra gray levels box, and set Limit number of distinct gray
levels to 512.

• Click OK in the Edit Style dialog.

• Now your style will appear in the list in the Separations Manager dialog.

Click OK to save the changes.

Operating Manual - PlateWriter
TM

 4200 0648

Using the RIP
4-7

Creating Separation and Progressive Styles



Creating Page Setups for Plate Making

General About Page Setups

The Navigator RIP allows for multiple Page Setups, each can be used to describe how
to handle a job that arrives at the RIP.
The Page Setup identifies which device will be used to output the file, which
separation style will be applied and thus the screening used to create the halftone.
It also describes the orientation and position of the job on the media, and finally the
actual media size itself.
Multiple Page Setups can be used for varying press sizes (2-up or 4-up) or orientations
(such as Portrait presses or Landscape presses) in a large print shop to allow plates to
be made for each press and position each plate correspondingly, or Page Setups can be
used to apply a different separation style if you get jobs from different sources, which
have been created differently.
Any combination of the above can also be applied or even a different output device
such as a Proofer.

Pre-defined Page Setups

To make things easier, if you printed the config.ps file as described earlier, then it
would have already installed some separations styles for you.

• Select Navigator -> Page Setup Manager from the NavigatorRIP menu.
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• This opens the Page Setup Manager window.

Here two different Press orientations and sizes are used, and in each case, two
different ways to handle jobs arriving have been defined.
You can use these Page Setups as they are or you can simply change them to meet
your requirements (such as larger plate size) or you can create your own.
However if you did not print the config.ps file to load the Page Setups as described
earlier, then you will need to create a Page Setup before you can use the RIP.
Follow the procedure as described below to create your own Page Setups if required, 
otherwise for an easier way to change the existing Page Setups loaded by the
config.ps file advance to the section titled "Duplicating and Editing a PageSetup"
directly following.

Creating Page Setups

• Select Navigator -> Page Setup Manager from the NavigatorRIP menu.

continues…
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• The Page Setup Manager dialog appears.

Click on New…

• The New Page Setup window opens.

• In the Output Device section select the device PlateWriter4200 and check that the
values in the Resolution section change to 1440.

• Click on the Configure Device button in the Output Device section.
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• The configuration window for the PlateWriter 4200 opens.

• Make following settings:
Set Media to Best Plate (Bi-Di. 8p)
Set PlateMaker to PlateWriter4200
Set PlateMaking Mode to 2 Channel
Click Ch1 + 2 (the channels for your Liquid Dot Ink)
Check the box Eject Plate After Imaging
Set Pre Imaging Sequence to Mode 2
Set Post Imaging Sequence to None

• Click on OK to continue.
Note that the symbols next to the Media names will show as red exclamation marks
before the device is set up.
Once you have saved these settings and saved your Page Setup, if you return to this
dialogue box, you will see that these have changed to green ticks as shown.

continues…
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• In the Separations, Screening & Colour section of the New Page Setup window
choose a Style – "SEPS (CMYK+Spot) to DEEDs2" was the one we created earlier, or
select it from the pre-defined Separations Styles loaded when printing the config.ps
file.

• If you did not print the config.ps file, then leave the fields in the Calibration & Dot

Gain section blank, and ensure you follow the procedure described in "Calibrating"

later in this chapter.

• If you did print the config.ps file then
– Set Calibration to iCTP Linear

This provides a linear output on the Plate
– Set Tone Curves to None
– Set Intended Press to 20% Dot Gain, or BDV-FOGRA positive gloss

As CTP equipment is generally calibrated to provide a linear press sheet, this adds 
back the gain normally expected by conventional printing presses and thus creates 
a richer output for 4 colour work than a linear press sheet would

– Set Actual Press to Press Gain 18 or Heidelberg PM 46 – Coated
This linearizes the output on the Press sheet, thus compensating for individual
press characteristics and the effect of the DEEDs screening
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• The New Page Setup screen should now look like this (if the config.ps file was

printed, otherwise each of the Calibration & Dot Gain items are set to None.

• In the Cassette & Page section click on the Page Layout.. button to open the Page
Layout window.

• Select units (inches or mm) for media size and margins. 
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Setting the Plate Size

For printing plates set the Media Width and Media Length to the width and length of
your printing plates
E.g. for a Heidelberg SpeedMaster 52 set Width to 529 mm and Length to 459 mm

Be sure that the plate will fit on the printer’s Alignment Mat in the orientation you are
defining.

"
NOTE! If your plate is portrait loading (such as an ABDick 9810;330x492mm, or 
a Heidelberg QM46; 340x505mm), then the PlateWriter will image your plate
faster if it is rotated 270° and imaged, so the plate needs to be loaded "long
edge first" (Landscape).
Therefore you will need to set the Media width to the long edge (e.g for an
ABDick 9810; 492mm) and Rotate the ‘job’ in the main PageSetup dialogue
box.

If the Page Setup is for proofing set the Media Width and Media Length to the width
and length of your proofing material.
Note that this will generally be a different size than your printing plates.
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Setting the Gripper and Job Position on the Plate.

Not all of the plate can be reproduced. Also, to reduce press make ready time it is
desirable to place the job at the same starting point in terms of height, and in the centre 
of the width of the plate. As all presses have an area at the top of the plate where some
of the plate is placed in the gripper,  you should first establish, where on the plate you
want your jobs to start. This is sometimes known as the Gripper Offset or Top
Margin.

Setting the Gripper and Job Position for Landscape Printing Presses

For Landscape presses, where the plate fits on the PlateWriter’s Alignment Mat long
edge first, the PostScript or pdf-file will generally be centred on the Media Width, and
the Top Margin will be the Gripper Margin plus the plate bend.

continues…
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Example for a Heidelberg SpeedMaster 52:
The plate is loaded Landscape (the long edge fits into the gripper).  
The plate size is 529 mm x 459 mm,  so set the Media Width to 529 mm and set the
Media Length to 459 mm as shown above.

Then check the  Centre page on Media Width box (this places the job, irrespective of
size, in the centre of the plate width) and ensure the Centre Page on Media Length is
not checked.
Finally the Top Margin box will be available for you to enter the position that you
want the image to start (the gripper margin) from the top plate edge to the start of the
job.
Both the Left Margin and Right Margin boxes will be greyed out, as the job will
automatically be centred by the RIP.

"
NOTE! The Page Size in the bottom left of the dialogue box, will be
overridden by the page size of the job being sent down from your application,
so the value here is not important,  however we recommend that you set it at
the largest job size you are ever likely to send to this plate (which should be
smaller than the plate size less the Top Margin).

"
NOTE! 4-up plate users that have a Landscape plate larger than 650 mm wide,
will need to place the plates on the Alignment Mat in the Portrait orientation – 
setting the Gripper and Job position for Portrait Printing Presses which
follows.
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• Click OK to return to the New Page Setup window.

Click the Save As... button.

• In the appearing Save Setup dialogue…

...give your Page Setup a name which reflects the press size and if necessary the
Separations Style so it will be easy to select later.
Click the Save button.

continues…
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• Click the OK button to exit the Page Setup Manager.

"
NOTE! If you Click Cancel at any point including to exit the Page Setup
Manager above, then any changes you made or new Page Setups will be lost.

Setting the Gripper and Job position for Portrait Printing Presses

For Portrait presses, the PostScript or pdf file in theory should be centred on the
Media Width, and the Top Margin should be set equal to the gripper margin plus the
plate bend.

However, in many cases it will be quicker for the PlateWriter to print the plate in the
Landscape orientation due to the fact that the plate has less far to advance.
In this case, the PostScript or pdf file should be set to centred on the shortened Media
Length, and the Left Margin will be set to the gripper plus the plate bend on the
printing press.
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Example for an ABDick 9810 press:
The plate size is 330 mm x 492 mm, and normally the narrow edge (330 mm edge)
would be the Grip and so would normally be the Top.
Set the Media Width to the plate length of 492 mm and set the Media Length to the
plate width of 330 mm as shown above.

Then check the  Centre page on Media Length box (this places the job, irrespective of
size, in the centre of the plate length) and ensure the Centre Page on Media Width is
not checked.
Finally the Left Margin box will be available for you to enter the gripper plus the plate
bend on the printing press.
Both the Top Margin and Bottom Margin boxes will be greyed out, as the job will
automatically be centred by the RIP.

• 4-up plate users that have a Landscape plate larger than 650 mm wide, will need to
place the plates on the Alignment Mat rotated as in the Portrait orientation for faster 
printing as in the example above. In these cases the guide for setting a rotated Page
Layout for Portrait presses should be followed.

continues…..
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• Click OK to return to the New Page Setup window.

• For Portrait Presses only (and Landscape presses that require the plate to be
rotated on the PlateWriter Alignment Mat):
In the Effects section set Rotate to 270. This will cause the top of the PostScript or
pdf to be nearest the leading edge of the plate on press.

• Click the Save As... button.
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• In the appearing Save Setup dialogue…

...give your Page Setup a name which reflects the press size and if necessary the
Separations Style so it will be easy to select later.
Click the Save button.

• In the Page Setup Manager dialogue...

...click the OK button to exit.

"
NOTE! If you Click Cancel at any point including to exit the Page Setup
Manager above, then any changes you made or new Page Setups will be lost.
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Duplicating and Editing existing Page Setups

Overview

One of the easiest ways to create new page setups is to duplicate an existing one and
change the items you require. The most common requirement is to create Page Setups
that match different Presses and Plate sizes.
In addition to this, you may wish to create a Duplicate of an existing Page Setup to
handle Jobs created by different sources differently.
For example, one workflow/customer may always supply the jobs rotated by 90° and
so you can create a Duplicate Page Setup, simply with the Rotation Page effect
switched on to correct this.
Alternatively, one workflow/customer may supply jobs separated, another may
supply jobs pre-separated. Again, duplicating the Page Setup and simply selecting
different separation styles for each Page Setup easily solves this problem.
Finally, you may find from time to time, you receive jobs that have been badly
constructed, and contain CMYK process inks and multiple spot colour inks, and so
again you can edit the Page Setup to override the separation styles to force all colours
to CMYK.

"
NOTE! Editing a PageSetup is easy, but remember that it will alter the Page
Setup you chose to edit. So it is recommended that you Duplicate/Copy the
Page Setup you want to base your new PageSetup upon, then change this
duplicate and leave the original Page Setup untouched.

Using "Copy" to Create a PageSetup for a different Plate Size

• Select Navigator -> Page Setup Manager from the NavigatorRIP menu.

"
NOTE! If you already have a Press Setup created, and you wish to add another
of a different size, then try to select a Setup with the same orientation (e.g. if
you have a Portrait Press setup such as an ABDICK 9810 and want to create a
different size such as a Heidelberg QM46)  and copy this Page Setup.
This will make creating the Page Setup much quicker as the only items to
change will be the Plate Size and the PageSetup Name.
Even if you do not have the correct Press orientation already created it will still 
be much quicker than creating a New Page Setup, however you will need to
check you have Centred the image on the Height (for Landscape) or the Length 
of the Page (for rotated Portrait) appropriately (see section on creating Page
Setups).
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• In this example we will add a Heidelberg MO (4 up) press (650 mm x 550 mm) to
our Page Setup list by copying and editing the GTO 52 (2-UP) Page Setup.

• From the list in the Page Setup Manager dialogue…

...select the Page Setup you wish to base your new Page Setup upon - in this case
select the GTO 52 Pre-Separated Page Setup and click Copy... to create a duplicate
Page Setup.

• The New Page Setup window will appear.

Click on the Page layout... button.

continues…
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• In the Page Layout dialogue…

..edit the existing Media Width and Media Length settings to reflect the plate size of 
your new Press Page Setup.
In this case plate width is  650 mm and plate length is 550 mm.
Set the new Top Margin if this press has a different Gripper requirement.
Click OK.

• You will be returned to the New Page Setup window.

Click Save As... to save your new Page Setup with the new plate size.
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• Give your new Page Setup a name to reflect the setting you have selected.

In this example name the Setup Heidelberg MO Pre-Separated.
Click Save.

• In the Page Setup Manager dialogue...

...verify that your new Page Setup appears in the list.
Click the OK button to exit.

"
NOTE! If you Click Cancel at any point including to exit the Page Setup
Manager above, then any changes you made or new Page Setups will be lost.

• You have now completed creating your new Press Page Setup.
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Printing a Job Using the RIP.

Using the Print File Command

When you select Print File from the Navigator RIP menu, the dialog box shown below 
appears.

Ensure you choose an appropriate Page Setup for printing the files, from the Page
Setup drop-down list.

"
NOTE! If you do not choose a Page Setup, the RIP uses the one that you chose
last time you printed a file. If you have not printed a file in this RIP session,
the first Page Setup in the drop-down list is used. To change the order of this
listing, simply drag the PageSetup you want at the top of the list into that
position in the PageSetup Manager.
See full RIP manual page 118 for further details.

The Print File dialog box shows all PostScript-language and PDF files in the current
folder.
To show files of a different type, or all files, use the Files of type drop-down list.

If you want to choose a file that is not in the folder shown, use the dialog box to
navigate to the correct folder.

"
NOTE! To select all files in the list, click anywhere in the central list of files
and type Ctrl+A.

While any file is being processed, an additional Print File menu appears on the menu
bar of the main RIP window.

You can abort the current job by choosing Kill Current Job from this menu, or by
typing Alt+ (a period character).

When Kill Current Job is selected, the current job is stopped but subsequent jobs will
be processed.

By selecting Stop Printing File, the current file will complete but any jobs queued after 
the current job will not print.
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Selecting Abort Printing File will stop the current job and also stop all subsequently
queued jobs from ripping.

Printing several files

To print out several files at once, just select more than one file from the Print File
dialog box before clicking Print.

The following keys make this possible:

You can select a contiguous block of files by selecting the first file in the block, then
selecting the last file in the block while holding down the Shift key.

You can select several non-contiguous file names by holding down the Ctrl key while
making your selection.

"
NOTE! The list of files to print can include files other than
PostScript-language, PDF files, TIFF 6.0, and TIFF/IT-P 1.
The RIP ignores types of files that it cannot print.
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Automating Job Input to the RIP.

Printing using Managed Input Plug-in’s or 'Input Queues'

This section describes the different ways in which the Navigator RIP can accept its
input, and how to configure the RIP to use each type of input.
 
There are several ways of providing input to the Navigator RIP:

• Using the Print File menu command, as described previously.
This command allows a user on the machine running the RIP to print all of the job
types possible on that installation of the RIP.
You can use Print File while managed inputs are active.

• Using one or more managed inputs, as described below, and the following sections.
This is the preferred method for routine use because, in general, the managed inputs 
allow users on many machines to submit jobs to the RIP.

When you use managed inputs or the Print File menu command, you can print several 
types of job.

The possible types, are:

• PostScript-language files (PS) and Encapsulated PostScript files (EPS)

• Portable Document Format (PDF) files.

• JPEG and JFIF files.

• TIFF/IT-P1 files.

• TIFF 6.0 files.

In the same way that the RIP uses output plugins to provide output sources such as the 
PlateMaker or Proofer, it uses Input Plug-ins to provide managed input sources.

There are a number of input plug-ins supplied with the RIP, each providing you with
the ability to submit jobs under different situations.
The full Xitron RIP manual describes all of these plug-ins, and the way in which you
can manage the inputs they provide. However in this section of the manual we cover
the most frequently used plug-ins, what they do and how to set them up.

The most commonly used inputs are:

• Spool Folder (also known as Hot Folders, or watched folders)

This lets you specify multiple independent folders into which users or applications
can place jobs to be printed. The RIP checks for the presence of files in these folders
and prints each one automatically.

"
NOTE! Folders can be shared across a network, however Apple Users will only 
be able to see PC networks if the Network has been configured with the
additional ExtremeZ-IP protocol provided or with SERVER based
applications.  The Normal mode of connection for Apple users is to use the
AppleTalk plug-in detailed below
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• AppleTalk

This publishes PageSetups in the RIP as a printer(s) on AppleTalk networks and lets
the RIP accept input from any Mac application that prints to the printer(s) broadcast
by the RIP.

• NT Print

This publishes the RIP as a printer available to the Windows NT print services, this
printer can then be shared to other PC users in a similar fashion to the AppleTalk
plug-in for Mac users.

Each of these plug-ins can have multiple configurations, each configuration is given a
unique name, then the input derived from the queue is linked to a specified Page
Setup, so the RIP can print the file.
This enables multiple Inputs from different sources for each page setup, and/or one
input plug-in to receive jobs for multiple Page Setups.

Example: A Print queue may be set up watching a specific folder (using the Spool
input plug-in), any files sent to this folder will be delivered to the page setup
associated with this print queue (such as PageSetup 1).

At the same time, an addition queue may be active, using the AppleTalk input
plug-in, a print queue can be created which broadcasts a ‘virtual’ printer on an
Apple Network.  Any jobs printed by a Mac user will be delivered to  the page setup 
associated with this Print Queue  (which could also for this example be PageSetup1).

Therefore, in this scenario the RIP allows different inputs (both AppleTalk and
SpoolFolders) to send jobs to the RIP and will automatically accept and handle them as 
they arrive.

Alternatively: A Print queue may be set up watching a specific folder (e.g. Folder
ABDick9810) using the Spool input plug-in, any files sent to this folder will be
delivered to the page setup associated with this print queue (such as a PageSetup for 
the ABDick 9810 press).

At the same time, an addition queue may be set up watching a different specific
folder (e.g. Folder GTO52) using the Spool input plug-in, any files sent to this folder
will be delivered to the page setup associated with this print queue (such as a
PageSetup for a Heidelberg GTO52 press) 

Therefore, in this scenario the RIP allows multiple folders to be published on a
network, and users can drag and drop jobs/files into to folder relating to the
appropriate page setup.  The most common example of this is to accept jobs for
different press sizes, so the RIP can orientate the job for each press, set the grip
position and then output the job.
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Managing Input Plugins

You control input plugins using the Input Controller. Before creating new inputs or
changing existing ones, check that you have an appropriate page setup which can be
associated with each input.

• Open the Input Controller dialog box either by choosing the NavigatorRIP -> Input 
Controller menu option or by clicking the tool bar button.

• The following Input Controller dialog box will appear.

The Input Controller dialogue box shows the input sources currently available. Each
input source can be turned on or off individually using the buttons— the state is
displayed in the Status column.

Each row in the list represents one particular source, and contains:
– The Name for the input source. This is used to identify the source within the RIP.

It may also be used by the input plugin itself.
– The Type of input. This determines which input plugin the RIP uses.
– The Page Setup. This is the page setup used by all jobs arriving through this

source.
– The Enabled state. This should be On to make the source available when you start 

the RIP or start inputs.
– The Status. This can be Stopped, Idle, or Busy.

An input is stopped either because all inputs are stopped, because you have disabled 
this input in the Input Controller (using Off), or because of a problem when trying
to start that input. An idle input is ready to receive a job but none is arriving. A busy 
input is actually receiving a job.

Below the list of sources are several buttons that allow you to perform the various
actions enabling you to create, copy or delete managed inputs.

When you have finished making changes in the Input Controller, you can keep it
visible as a way of monitoring which inputs are submitting jobs or close it either by
using the Navigator RIP -> Input Controller menu option or by clicking the tool bar 
button.
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Turning on the input system

To start receiving jobs from the configured and enabled inputs, choose the
NavigatorRIP -> Input Controller menu option or clicking the tool bar button.

T
he tool bar button is the most frequently used way to start or stop the queues, and
simply uses icons representing Traffic Lights.

Click the Green Traffic Light to start the queues, and the Red Traffic Light to stop the
queues.

"
NOTE!  When you start the Queues, there is a delay of a few seconds as the
various defined input sources are initialized, and then the RIP starts to accept
jobs from those sources.

The status area of the tool bar shows the searching for input symbol (a torch or
flash-light shining on an arrow).

A new menu appears in the menu bar, called Input Queue.

This menu has these options:

• Kill Current Job: This causes the job currently processing to be aborted. It may take
a few seconds.

• Stop Input Queue: This turns off the input system when the job currently
processing has finished.

• Abort Input Queue: This aborts the job currently processing and then turns off the
input system.

Adding a new input source to the list

You can create many different input sources for each input plugin. For example, you
could create 5 spool folder input sources and 10 AppleTalk input sources.

To add a new input source to the list:

• Click the New button in the Input Controller window. The RIP displays an Input
Channel Edit dialog box, allowing you to fill in the details for this source.

continues…
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• Type a name for the Input plugin device in the Name text box.

"
NOTE! The name is used to identify the source within the RIP. It may also
be used by the input plugin itself. If you create an AppleTalk input device,
when you start the inputs a ‘virtual printer’ with this name becomes
available on the AppleTalk network.
Try to use names that allow you to identify which PageSetup the jobs will
be sent to.

• Choose the plugin type from the Type drop-down list. (e.g. AppleTalk, or Spool
Folder)

• Choose a saved page setup from the Page Setup drop-down list. The RIP applies
this page setup to each job arriving at the source.

• If the plugin is to be initially turned on, select the Enabled check box.

• Click the Configure button to display an Input Plugin Configuration dialog box,
allowing you to specify details relevant to the input plugin you have chosen.
The Configuration dialog box varies according to the type of plugin chosen. It is
used to give details about how the input is to be handled, e.g. for Spool Folders, it
tells the RIP which folder to watch for jobs. See below for the configuration and use
of this box.

• When you have specified all the details for the new source, click OK.

Copying an input plugin

When you have created an input plugin, you can copy it to create other inputs of a
similar type. This can save you some effort, depending on the complexity of the
Configuration dialog box.
To copy an existing input, select the entry in the Input Controller and click the Copy
button.
You must give the copied input a new name and you will probably need to alter some
details in the Configuration dialog box. For example, only one active input can use a
particular spool folder or network input at one time - but you can have two or more
inputs using the same source, provided that you enable only one at a time.

Editing the details for an input source

To edit the details for an existing input source, do one of the following:

• Select the entry in the Input Controller and click the Edit button.

• Double-click the entry in the Input Controller.

The RIP displays an Input Channel Edit dialog box, allowing you to edit the details for 
the selected plugin. 
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Configuring an input plugin

Configuring an input means giving details about how the input is to be handled, and
setting up any hardware or software associated with the source.  To configure an
existing input plugin, select it in the Input Controller and click Edit.
The RIP displays the Input Channel Edit dialog box.
Click Configure to see the Configuration dialog box for the selected input. 

Deleting an input source

To delete an input source from the RIP, select it in the Input Controller and click the
Delete button.
You can select multiple inputs and delete them in one action.

Enabling and disabling input sources

To enable an input source, select it in the Input Controller and click the On button.
To disable a source, select it and click the Off button.
Using these buttons has the same effect as selecting or clearing the Enabled check box
in the relevant Input Channel Edit dialog box.

When the selected input source is enabled then the On button is disabled, and when it
is not enabled then the Off button is disabled.

You can select several input sources and then turn them on or off together.
When an input plugin is enabled, the RIP automatically publishes it when starting
input queues, meaning that the input plugin can be used to send jobs to the RIP.
To make enabled inputs active, choose NavigatorRIP -> Start Inputs or click the
Green Traffic Light tool bar button. 
To stop all enabled inputs, choose NavigatorRIP -> Start Inputs again or click the Red
Traffic Light tool bar button
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Using the Spool Folder Input folder

The spool folder input is the most popular managed input for PC users.  The Spool
plug-in regularly scans a specified disk folder (directory), and processes any
PostScript-language files (and other suitable files) that are placed there. Normally these 
files are deleted after successful processing. The spool folder can be on a network file
server, or the local iCtP RIP Workstation. Users create files from their applications.
These applications can create the files directly in the spool folder, or can create them
elsewhere (for example, on the local system) for later transfer into the spool folder.

The RIP can process some or all of the following file types using a spool folder:

• Post-Script-language (PS)

• Encapsulated PostScript (EPS)

• Portable Document Format (PDF)

• TIFF 6.0

• JPEG and JFIF files.

The RIP ignores types of files that it cannot print, and any files that you exclude
intentionally by configuring the spool folder input.

You can exclude files based on their names. You may want to exclude files that
resemble real jobs, but that actually contain accounting or housekeeping information
for the software that delivers files into the spool folder. You may also want to exclude,
or at least delay, real jobs with particular origins or qualities. All this is possible so long 
as the file names have a recognizable prefix.

You specify which folder the RIP uses in the input plugin Configure dialog box,
available from the Input Controller.  If needed, you can create several spooled inputs,
each with its own folder, page setup, and exclusion list.

When you specify a folder accessed over a network, make sure that the folder
automatically becomes available to the computer running the RIP when that computer
is restarted.  Because files are normally deleted as soon as they are printed, it is
important to ensure that the RIP has permission to delete files in the spool folder,
particularly if the spool folder is on a network file server.

The files in the spool folders are processed in the order in which they arrive. However,
if there are jobs already in a folder when the RIP is started, or if a very large number of
files have been queued, the RIP determines the order of those jobs by the date stamps
on the files.
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Creating and Configuring a Spool Folder Input Source 

To create and configure a new Spool folder source do the following:

• Open the Input Controller dialog box either by choosing the NavigatorRIP -> Input 
Controller menu option or by clicking the tool bar button.

• The Input Controller dialog box will appear.

Click New

• The RIP displays the Input Channel Edit dialog box.

• Choose SpoolFolder from the Type drop-down list.

continues…
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• Select the Page Setup you wish to receive and process jobs that arrive in the spool
folder (here we have selected the GTO52 Pre-Separated Page Setup).

• Give your input queue a Name (try to use names that reflect the PageSetup you are
sending it to, to make editing queues later a little easier).

• Click on the Configure button to open the Spool Folder Configuration window.
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• The Spool Folder Configuration window contains the following control items:

Spool Folder
The current spool folder is shown in the text field beside this button. This location is
where the RIP detects the arrival of files and considers them as possible jobs, by
looking at the type of file and any file names excluded in the Filenames pre-fix list.

"
NOTE! Choose a folder that is dedicated to receiving jobs. In particular,
avoid using folders where other files are arriving or changing (for example,
the SW folder is a bad choice, because the log file changes with every job).

Click the Spool Folder button to change this folder using the standard file browsing
dialog box.

"
NOTE! Alternatively you can type a full path name in the text field but be
aware that any typing errors can cause an error or the creation of a new
folder.

We recommend that you create a folder called Jobs, and in there create folders for
each Press and Plate Setup you have created as Page Setups.

In this example, as we have created a Spool Folder queue that sends jobs to the
GTO52 Pre-Separated Page Setup, we have named the folder the same, so when you  
drop the files into the folder you will know which Page Setup will be applied to the
job.

Create spool folders if they do not exist:

Select this box if you want the RIP to create the named spool folders if they do not
already exist.
The RIP creates the folders when the input channel becomes available for use. This
time can be immediately after you click OK in the Input Channel Edit dialog box for 
an enabled channel, but you may need to choose NavigatorRIP -> Start Inputs or
enable the input channel before it becomes fully available.

Warn if spool folders do not exist
Select this box if you want the RIP to issue a warning if a folder named as a spool,
error, or completion folder does not exist.

continues…
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Error Folder
If a file fails to print, the RIP moves it to the error folder specified unless the Delete
on error box is selected. If a file prints successfully, the RIP moves it to the Complete 
Folder specified unless the Delete on completion box is selected.
Again, we recommend you change the default here to a folder called Error inside
your main Jobs folder.

Delete on error
Select this box if you want the RIP to delete files that the Spool folder fails to print.
Leave this box clear if you want failed files to be moved to the Error folder.

"
NOTE! We recommend you do not check this box, so that you can check
which files creates an error, then you can take at look at them to determine
why.

Note that a file is treated as an error if you abort it while it is being processed.

Move/Delete All Files
With this option selected the spool plugin will either move to the Error folder, or
delete any file which it does not recognize (such as badly formed PDF documents).
The files are moved or deleted depending on the state of the Delete on error check
box.

$
CAUTION! If you decide to use this option and you inadvertently choose to
point the spool folder at a directory containing important files (such as C:
\windows… or your SW folder) you will remove all files in this folder,
resulting in either a non-functional computer or non-functional
applications. The plugin deletes or moves all the files it cannot handle.

Move/Delete Valid Files
In this case, if a file is encountered which the spool plugin does not recognize it will
leave the file in the spool folder and ignore it. Valid files which cause an error will be 
treated according to the setting of the Delete on error check box.

Complete Folder
If a file successfully prints, the RIP moves it to the location specified in the text field
beside this button unless the Delete on completion box is checked.
Click the Complete Folder button to change this location using the standard file
browsing dialog box.
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Delete on completion
Select this box if you want the RIP to delete files that the Spool folder succeeds in
printing. Otherwise the RIP moves these files to the Complete folder.

"
NOTE! Generally we recommend deleting jobs after printing successfully. 
However, there are circumstances where this is useful, such as moving the
job into another folder for RIPPing, like the Proofing folder.  So you can
supply Plates and Proofs at the same time from the same file.

Filenames prefix list
This text field specifies files to ignore when they arrive in the spool folder, if you
have also selected the Exclude prefix list box. The specification is based on the first
part or prefix of the file names.
Prefixes are case sensitive.
You can enter several prefixes. Separate multiple prefixes by commas without
surrounding spaces. If you add spaces after a comma, the RIP treats the spaces as
part of the following string. Each prefix can include alphanumeric characters, the
underscore character, the period character, and spaces.
For example, this is a valid list of three prefixes: aaab_c, BAC, 4.4

Exclude prefix list
Check this box to make the prefix list active. Leave this box empty to disable the
prefix list without deleting the list of prefixes.

Scan spool folder every <n> seconds
The value in the text box specifies how often the RIP checks the Spool folder for new
files to be printed.

Time to wait for file to stabilize <n> seconds
The value in the text box specifies the number of seconds that the Spool folder waits
for the size of an arriving file to remain the same before assuming that it has been
fully written and is therefore ready to be printed.

Suppress startup warnings
If you have files present in the Spool folder and then start the RIP, you will be
prompted with a warning that files already exist in this folder which you must
acknowledge before the RIP will start. If you would prefer to suppress these startup
warning messages and continue to start the RIP, select this option. All files present
in the folder will be processed.

• Having set all the configuration options click OK. Your Input Queue is now ready to 
use.  If you have now set all the queues up and want to activate them, click the
Green Traffic Light button on the tool bar to start your queues.

"
NOTE!  If you want to set up multiple queues based upon different page
setups, select the Spool Folder queue that you have just setup, then use the
'Copy' button at the bottom of the Input Manager dialog box.  Then give
your copied input queue a different name,  select the new page setup which
you wish to send the jobs to, then click 'Configure'. Now you only need to
change the 'Spool' folder, to reflect a new folder to act as the source for your
new queue.
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Using the AppleTalk Input Plugin

With the AppleTalk Plugin, the user defines a name and defines a Page Setup from the
RIP to associate to that name (Queue).  The name (Queue) is then published by the
AppleTalk input source over the Apple network. This name (queue) appears in the
Chooser on Macintosh computers connected to the network very much like a Laser
Printer (so, in effect the Name/Queue is a virtual printer hosted by the RIP).
When Mac users select this name (Queue) they can then install the ‘Virtual Printer’
hosted by the RIP, just as they would a LaserPrinter. Users can create multiple Queues, 
each associated with different Page Setups.  So, the Chooser will see multiple
‘printers’.  After this users simply select the Printer relating to the Page Setup they
wish to send jobs to and then print directly from the application they are using.
When jobs arrive from the Mac, the RIP detects which ‘virtual printer’ they were sent
to, applies the associated Page Setup and processes the job accordingly.

Configuring an AppleTalk input source

• To create an AppleTalk input source, select the source in the Input Controller and
click New. The RIP displays the Input Channel Edit dialog box.

Enter a Name for your Queue.

"
NOTE! As this name will be broadcast over the AppleNet work to identify
your queue (and will essentially appear as a printer in the chooser) select a
name that clearly identifies the Page Setup the job will be sent to.

For example for the Page Setup GTO 52 Pre-Separated you could set the Name to
‘Plates for Heidelberg'.
Or if you have a proofer, you could set the Name to Proofer.
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• After you have entered the name, select AppleTalk from the drop down menu in
the Type box.

The AppleTalk Input Plug in is amongst the simplest to set up, and there is nothing
that needs to be configured for this plugin, so you can now click OK and the plugin is
ready to use.
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Using the NT Print input

This input publishes the RIP as one or more printers available to the Windows NT,
2000, and XP print services. Once fully installed and configured, each printer has a
name visible to Windows operating systems.

There are several stages to installation and configuration, which you must carry out in
the following order:

• Installing the plugin.

• Configuring the RIP to make the input available.

• Configuring Windows to associate a printer with the RIP input. 

Installing the plugin

When your RIP was installed, the installer placed the NT Print plugin install wizard in
the C:\Program Files\Xitron_7.0r3\NTPrint folder.

Use the Installation Wizard as described below:

• Exit all running applications.

• Run the file Setup.exe found in the \Ntprint folder.

• When the installation program asks you, choose the folder in which the Navigator
RIP is installed.
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• Click on Browse and select the folder where your RIP is installed.

This should be C:\Program Files\Xitron_7.0r3.
Click OK

• Wait for the installation process to finish…

...then reboot the computer.

Creating an NT Print Input

Having installed the plugin as described above, you can create a Navigator RIP input.

• Click New in the Input Controller. The Input Channel Edit dialog box appears.

Give the input a suitable name.

continues…
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• Choose NT Input from the Type drop-down list.

• Select a Page Setup then check the Enabled box.

• Click the Configure button. The NT Print Configuration dialog box appears. 

The dialog box contains controls to allow for the situation where RIP inputs have
started up before the Windows spooler system - this is possible on fast machines.
The default is to accept failure, in which case the printer will be unavailable without
some user intervention. You can make the RIP keep trying, within a time limit, by
using the controls.

Enable
Select this box if you want the RIP to retry making a connection to the Windows
spooler after initially failing.

Retry delay
Enter the time, after the initial failure, for which you wish the RIP to continue
retrying. A retry delay of 60 seconds is likely to be enough on all machines. Too long 
a delay means delaying jobs on other inputs, so reduce this figure if you have no
problems.

• Click OK to close the NT Print Configuration window.

• Click OK in the Input Channel Edit dialog box to close it.

• Use Navigator RIP -> Start Inputs to start inputs (or the Green Traffic Light icon on 
the toolbar).

You now have a RIP channel that forms a port visible to the Windows printer
configuration software.
Next you must add a printer under Windows XP.
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Creating a Printer under Windows XP

You have two options. Either you can create a new printer to use the RIP channel, or
you can connect an existing printer to the RIP channel.
The procedures are similar for Windows XP and Windows 2000.

To create a printer for Windows XP:

• Using the NavigatorRIP -> Input Controller, create and start a new input channel of 
the type NT Input as described earlier in "Creating an NT Print Input".

• In Windows, from the Start menu select Settings -> Printers and select Add Printer.
The Add Printer Wizard appears.

Click on Next.

• Select Local printer attached to this computer and ensure that the Automatically
detect and install my Plug and Play printer check box is not checked.

Click Next.

continues…
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• Select Create a new port and select ScriptWorks from the drop down selection box
(this is the input added to Windows by the Harlequin RIP).
Click on Next.

A list box is then displayed showing the names of all unconnected ScriptWorks
Channels (that is the name of any input, you have created using the NTPrint Plugin). 
Select one of these and click OK.

• Configure the printer. To do this you need to install the printer driver for the
PlateWriter4200 supplied on the PW4200 Installer CD.

Click Have Disk…
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• Insert the PW4200 Installer CD ROM. Open the Windows Postscript Driver folder.

Select the iCTP_Win2K-XP.INF file and click Open.

• Click OK.

• The iCTP Postscript Driver will be displayed.

Select it, then click Next.

continues…
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• Now you must give your printer a name. By default Windows will use the iCTP
Postscript driver name, however you will want to choose a name, to reflect which
Page Setup the jobs will be delivered to for users using this queue.

Name the printer (we suggest you use the PageSetup name or something close to it).
Click Next.

• Choose whether or not to share the printer (for other Network users to see) giving it
a shared name if you do share it.

Click Next.
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• Windows will ask you if you wish to print a test page.

This is not necessary, so select No and click Next.

• Finally, you will see a Completion screen summarizing the details fo the printer you
have added.

Click Finish.

• Windows will copy over the files it needs from the CD ROM.

• Installation is complete. 

continues… 
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If you later want to reassign the printer to another port, do this:

• Choose the menu option Start -> Settings -> Printers.

• In the Printers window, select the printer, right-click and choose Properties.

• In the Properties window, click the Ports tab. Choose a new port by selecting its box
in the list of ports.

• Click OK to confirm the changes.

Using the Printer from Windows 2000/XP

The new printer is now connected to the RIP. Any printer output sent to the new
printer will be routed to the RIP.
The Windows spooler will remember the names of the printers between reboots of the
computer running the Navigator RIP. 

#
WARNING!  If an attempt is made to send a file to a printer attached to a RIP
channel that is not currently running (i.e. you have launched the RIP but
forgotten to start the Channels) a warning is displayed in Windows that the
port is not available and the user is given the chance to retry the job.
If this occurs, if you start the RIP input channel before the user retries the job,
the job will restart successfully.

Using More than One Method

The RIP can use any combination of the above input types and listen on all active
inputs. When several inputs want to send data, only one job can reach the RIP at a time 
but the other inputs may be able to receive and buffer data for later rendering.
To accept input from several sources, create and enable the sources you want in the
Input Controller. The RIP automatically monitor all enabled sources as soon as the
input system is started with the Start Inputs menu option.

Enhanced File Management and Printing for Mac Users.

To further enhance the printing options for Mac Users, an additional application is
supplied, called ExtremeZ-IP.
This installer is automatically copied into your AppleTalk folder in the RIP folder,
during installation.
For details of the ExtremeZ-IP application please refer to the Manual supplied in this
folder.
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Calibrating

Why Calibrate

The function of Calibration Curves is to linearize output on your plates. There are
several approaches on the use of the remaining curves. Generally, if you use the Actual 
press calibration curve to linearize your press then you will be printing with linear
plates that will produce flat images. For some users this will be the desirable effect, as
a 10% tint on screen will reproduce a 10% tint on the printed sheet; this is preferable
for spot colour users.
However, in CMYK (4 colour process) work, the flat image created by a linear output
will give a dull uninteresting image. In these cases use of the Intended Press curve or
tone curves will provide the needed correction and are used to "put back" the dot gain
that is assumed in the pre-press process.

Although the calibrations that we include in the RIP installation process are reasonable 
starting points, you may find that it will be necessary to create Calibration Curves for
your press, papers, and inks to produce high quality printed results.

Using Calibration to Linearize Output on Your Plates

"
NOTE! It is necessary to have an existing Page Setup to use this calibration
procedure. Follow the instructions in this document to create you own Page
Setup or apply the calibration procedure to one of the standard Page Setups
created during RIP installation by printing the config.ps file.

• Start the Navigator RIP.

• If necessary, open the Output Controller / Monitor window by either pressing
Ctrl+O or choosing Output -> Output Controller from the RIP menu.

• Be sure that Disable Output is checked. This will allow you to control the start of
printing in the next steps.
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• Choose Output -> Print Calibration from the RIP menu.

• Choose a page setup and click on Print uncalibrated target. The calibration target
will be ripped and written to disk.

• Load a plate onto the PlateWriter's Alignment Mat and move it to the
READY-position as described in "Loading Plates" earlier in this manual.

• Press and hold the [SETUP] key on the Control Panel for 1 sec.

• In the Output Controller/Monitor window select Uncalibrated target in the Active
Queue.
Click on the Info button to open the ThroughPut Info dialog.

continues…
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• Click on Page layout....

• Check that the Media Width, Media Length and Margins are correct for your plate.
(The calibration target is pretty small, but you should check to ensure the margins
will put it inside your printing area).

• Uncheck Disable Output in the Output Controller / Monitor window.
A target similar to this illustration will be printed.

• After the target has printed, remove the plate from the PlateWriter.

• Place the plate on the front of the PlateWriter's Finishing Unit. 

• Use a high quality reflection densitometer capable of reading stochastic dots, or
comparable device, to measure the dot% for each of the patches on the printed
calibration target.
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• Choose Output -> Calibration Manager from the RIP menu.

• Choose the same Device type as was used to print the target.

• Select Monochrome as the Colour Space.

• Click on New....

• Name the new calibration and enter the modified column of Dot% measurements in
the edit boxes. You may Smooth the data after it is entered.

• Click on OK in this window and in the Calibration Manager window to save your
profile.
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Including the Linear Calibration in Page Setups

Editing the Page Setups

• Choose Navigator -> Page Setup Manager from the RIP menu to open the Page
Setup Manager window.

• Select the Page Setup that was used when printing the uncalibrated target and click
on Edit to open the Edit Page Setup dialog.

• In the Calibration & Dot Gain section select the Calibration you just created.

• Leave the Tone Curve set to (None).

• Save the edited page set up by clicking on OK in this window and in the Page Setup 
Manager window.
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Confirming your Linearization on Press

• Choose Output -> Print Calibration… from the RIP menu.

• In the dialog box, choose the page setup just edited and click on Print calibrated
target. The calibration target will be ripped and written to disk.

• Follow the procedures used for printing the uncalibrated target, and confirm that the 
output is linear on your plate.

Calibrating your Press

Calibrating your press using the Actual Press Curve function will provide you with a
Linear press sheet, so that 10% on screen prints as 10% on press, 50% as 50% etc.
If we simply stop here, there are many circumstances where this whilst being accurate,
is not really desirable.
Typically older press work produced by film will suffer Press Gain at around 20% and
this gives a warm, strong image. A linear calibration will often give a very flat looking
result. However, linearising your press is important as it provides a start point and
removes the variables caused by varying press gains and worn press rollers which can
be created in a multi-press environment.
Having Linearised your press and create a calibration we call the ‘Actual Press’
calibration we can then add back an Intended Press Calibration curve, thus enabling a
print shop with multiple presses create a more consistent and even calibration across
all its work.

• Start the Navigator RIP.

• If necessary, open the Output Controller / Monitor window by either pressing
Ctrl+O or choosing Output -> Output Controller from the RIP menu.

• Be sure that Disable Output is checked. This will allow you to control the start of
printing in the next steps.

• Ensure that you have applied a Plate Calibration to the Page Setup you wish to
create a Press calibration for (see earlier in this chapter).
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• Choose Output -> Print Calibration from the RIP menu.

• Choose a page setup and click on Print uncalibrated target. The calibration target
will be ripped and written to disk.
You should get 4 separations.

• Load a plate onto the PlateWriter's Alignment Mat and move it to the
READY-position as described in "Loading Plates" earlier in this manual.

• In the Output Controller/Monitor window select Uncalibrated target in the Active
Queue.
Click on the Info button to open the ThroughPut Info dialog.
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• Click on Page layout....

• Check that the Media Width, Media Length and Margins are correct for your plate.
(The calibration target is pretty small, but you should check to ensure the margins
will put it inside your printing area).

continues…
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• Uncheck Disable Output in the Output Controller / Monitor window.
Once the Throughput window shows activity re-check the Disable Output
checkbox.
A target similar to this illustration will be printed.

• After the target has printed, remove the plate from the PlateWriter.

• Place the plate on the front of the PlateWriter's Finishing Unit.

• Load the next plate and repeat the above procedure for each plate.

• Each plate should then be put on the printing press, and an even ink density should
be achieved before printing reference sheets.
In Europe the Fogra Standard suggests selecting three typical types of paper stocks:
- Gloss Art: Set the ink densities to C=1.37 D, M=1.4 D, Y=1.03D, K=1.53 D
- Silk/Matt: Set the ink densities to C=1.16 D, M=1.24 D, Y=1.01 D, K=1.46 D
- Unbolted: Set the ink densities to C=0.76 D, M=0.93 D, Y=0.75 D, K=0.97 D
Each paper stock reacts differently to the press ink and changes the gain achieved on 
press.  Similarly the amount of ink laid down will impact results.  So if you do not
wish to adhere to the Fogra standards, then ensure you have some consistent
densities that you will to continue to work with.

For example, standard Commercial Work in the USA would typically see the ink
densities set to C=1.37 D, M=1.38 D, Y=1.06D, K=1.75 D

• Run each stock through the press, ensuring your reference sheet achieves the correct

ink density.

• Once the sheets are dry, use a high quality reflection densitometer capable of
reading stochastic dots, or comparable device, to measure the dot% for each of the
patches on the printed calibration target. It is not unusual for each ink to achieve a
different gain characteristic, so you will need to separately measure each colour
printed.
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• Choose Output -> Calibration Manager from the RIP menu.

• Choose Printing Press as the Device type.

• Select CMYK as the Colour Space.

• Click on New....

• Name the new calibration in relation to the Press and Paper type that was used.

• Select the Press type as Linear and Select the first colour channel Cyan to enter the
Cyan data into.

• Enter the modified column of Dot% measurements in the edit boxes.

• Once you have entered the Cyan data select the Magenta channel and enter the data 
measure for the Magenta output.

• Repeat the above for the remaining colours.

• Click on OK in this window and in the Calibration Manager window to save your
profile.
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Including the Press Calibration in Page Setups

Editing the Page Setups

• Choose Page Setup Manager from the RIP menu to open the Page Setup Manager
window.

• Select the Page Setup that was used when printing the uncalibrated target and click
on Edit to open the Edit Page Setup dialog.

• In the Calibration & Dot Gain section select the Calibration you just created from
the Actual Press calibration list.

• Leave the Tone Curves and the Intended Press curve set to (None).

• Save the edited Page Setup by clicking on OK in this window and in the Page Setup
Manager window.
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Why Use Intended Press or Tone Curvesquestion

The calibration process we have outlined is used to linearize the printing process using 
the PlateWriter 4200.
Linear printing means that a nominal 50% dot (gray level) will print as 50% on press.
Typically this will result in light or “washed out” looking print since most images are
pre-compensated for 20% dot gain. This means that images are generally prepared
expecting a nominal 50% dot to print as 70%.
Intended Press Curves are used to add the expected gain back into the press profile.
Tone Curves are used to modify this further to create cool looking images or warm
images.
We have not included any tone curves so this section details the use of the Intended
Press Curve to create the expected dot gain from conventional film etc..

We have included curves for Standard (20%), 15%, and 22% dot gain along with
Commercial, SWOP and Forgra curves with the Navigator RIP . These values are a
good starting point.

You may need to fine tune these Intended Press Curves to meet your particular
requirements. However to use one of the existing Intended Press curves, follow the
procedure below to implement the Intended press curve in your Page Setups.

Including the Intended Press Curves in Page Setups

• Choose Page Setup Manager from the RIP menu to open the Page Setup Manager
window.

• Select the Page Setup that was used when printing the uncalibrated target and click
on Edit.

• In the Calibration & Dot Gain section select as the Intended Press curve one of the
curves included in the Navigator RIP installation or one of the curves loaded when
printing the config.ps  file, or any custom Intended Press curve you may have
created.

• Save the edited Page Setup by clicking on OK in this window and in the Page Setup
Manager window.

• You can confirm if the output of your intended curves achieves the results you
required by printing a Calibrated Press Target.
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Backup & Restore your NavigatorRIP Configuration for
Windows

"
NOTE! It is very simple to backup your configuration of the Navigator RIP.
If you follow this simple backup procedure you will preserve all of your
Passwords, Memory settings, Calibrations, Tone Curves, Device and Page
Setups etc.

"
NOTE! Having a backup of your RIP configurations is likely to save you hours 
of work if any problems occur with your workstation or if you need to reinstall 
the Navigator RIP.

Configuration Backup

Having configured your RIP follow the instructions below to make a backup file of
your settings:

• Start the Navigator RIP.

• Select Navigator -> Print file from the RIP Menu.

• In the print dialog, set the Page Setup to Default Page Setup and the Files of Type
to PostScript (.ps)

• Choose the file BackupConfiguration.ps which is found in C:\Program
Files\Xitron_7.0r3\Utilities.

• Click on Print.
This will create (or overwrite an older version of) config.ps and put it in the same
folder as BackupConfiguration.ps.

• Make a backup of config.ps on removable media and store it in a safe place.

How to Restore your Configuration

Follow the install instructions for Windows on the Navigator RIP install CD.
When you are instructed to print the config.ps file from the install CD, print the
config.ps file which you have backed up instead.
Follow the instructions to configure the RIP memory and dongle passwords.
Your entire configuration will then be restored, and you can go back to work.
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Part 5: Trouble Shooting

General

If the PlateWriter does not work properly, refer to the following pages to find the
paragraph that comes closest to your problem.

The trouble shooting guide is divided into 3 sections:

• Problems with the Printer
• Problems with the Finishing Unit
• Problems with Printed Material

"
NOTE! To change a fuse, switch off all power to the machine first.
Always ensure that the new fuse is of the correct size and rating according to
the diagram.
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Problems with the Printer

General

The Printer does not run

Is the power cable
connectedquestion

Connect the cable securely.

Are you using a lengthy USB cable 
or a USB hubquestion

Use a shielded USB cable having a length of
max. 3 metres.
Never use a USB hub or the like.

Is the power switched onquestion Switch on the printer’s main power, then press
the sub power switch and make sure the
POWER light comes on.

Is the [SET UP] light onquestion Printing is not performed when the [SET UP]
light is not on.

Lower the loading lever, then close the front
cover.

Is the front cover openquestion Close the front cover.

Is the top menu displayedquestion If the top menu is not displayed, printing does
not start even when data is sent from the
computer.

Press [MENU] key to display the top menu.

Is the [PAUSE] light onquestion When the [PAUSE] light is on, operation is
paused. To resume, press [PAUSE] key.

The [PAUSE] light goes dark and printing
resumes.

Has ink run outquestion When printing data is sent while the screen
shown in the figure is displayed, a message
appears and a warning beep sounds. At the
same time, operation pauses. When the ink
cartridge is replaced with a new one, printing or 
cutting starts.

Is there a Message on the
Displayquestion

See "If a Message Appears" later in this chapter
for details.
See "If an Error Message Appears" later in this
chapter for details.

Are the voltage switches set
correctlyquestion

Set the voltage switches correctly to match the
voltage in the region where you’re using the
machine.

For information on how to make the settings,
refer to the "Hardware Installation Manual".
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Messages

These are the main messages that appear on the machine’s display to prompt correct
operation. They do not indicate any error. Follow the prompts and take action
accordingly.

CLOSE THE COVER Front, left or right side cover is open.

Close the front cover and the left and right side
covers. For safety, the carriage does not operate
while a cover is open.

[1 2 3 4 ] Ink Cartridge is empty.

If ink runs out during printing, a warning beep
sounds and this appears on the display.
The empty cartridge number and "_" will flash
(in this case cartridge 1).

Replace empty cartridge as described in chapter
3.

EMPTY DRAIN BOTTLE Discharged Ink Bottle full.

Detach the drain bottle from the machine,
discard the discharged fluid, then reinstall the
drain bottle on the machine.

Press [ENTER] to continue.

This message appears before operations that
discharge a large amount of ink.

INSTALL DRAIN BOTTLE Discharged Ink Bottle not installed.

Install the drain bottle, then press [ENTER].

TIME FOR MAINTENANCE It is time to clean the printing heads using the
Cleaning Kit.

After verifying, press [ENTER].

See "Cleaning the Heads Using the Cleaning
Kit" in chapter 3 for details.

TIME FOR WIPER REPLACE It is time to replace the wiper.

After verifying, press [ENTER].

See "Replacing the Wiper" in chapter 3 for
details.

TIME FOR SPONGE REPLACE It is time to replace the ink-absorbing Sponge.

After replacing, press [ENTER].

See "Replacing the Sponge" in chapter 3 for
details.
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Error Messages

This describes the error messages that may appear on the printer's display, and how to
take action to solve the problem.
If the action described here does not correct the problem, or if an error message
appears that is not described here, please contact a Service Technician.

SHEET SET ERROR The Printer has no registration of the Plate
Alignment Mat.

If Plate Alignment Mat is in LOAD-position
move it slightly backwards by pressing the
Up [ ] key for a few seconds, then press the
[EJECT PLATE] key and the Mat will
return to the LOAD-position.

If Plate Alignment Mat is in READY-position
move it slightly forwards by pressing the
Down [ ] key for a few seconds, then press the
[LOAD PLATE] key and the Mat will
move to the LOAD-position.

PINCHROLL ERROR INVALID
RIGHT POS

The right pinch roller is out of position.

See "Positioning the Pinch Rollers" in chapter 3
for details.

PINCHROLL ERROR INVALID
LEFT POS

The left pinch roller is out of position.

See "Positioning the Pinch Rollers" in chapter 3
for details.

DATA ERROR CANCELING… Output was stopped because a problem was
found in the data received.

Operation cannot be continued. Check for
problems with the connector cable or the
computer, then redo the operation, starting with 
reloading the media.

MOTOR ERROR TURN OFF
POWER

A motor error occurred.

Operation cannot be continued. Switch off the
sub power.

Next, eliminate the cause of the error, then
immediately switch on the sub power.

If the machine is allowed to stand with the error 
uncorrected, the print heads may dry out and
become damaged.

TEMPERATURE IS TOO LOW The temperature of the location where the
machine is installed has fallen below the
ambient temperature at which the machine can 
operate.

Operation cannot be continued. Switch off the
sub power. Bring the installed location to a
temperature at which operation is possible, 15
to 32°C (59 to 90°F), then turn on the power.
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TEMPERATURE IS TOO HIGH The temperature of the location where the
machine is installed has risen above the
ambient temperature at which the machine can 
operate.

Operation cannot be continued. Switch off the
sub power. Bring the installed location to a
temperature at which operation is possible, 15
to 32°C (59 to 90°F), then turn on the power.

CANCELLED FOR PROTECTING
MOTOR

Continuous operation made the pump motor
become hot, and so operation was paused.

Press any key to clear the error. Allow the
machine to stand for approximately 40 minutes,
then resume operation.

AVOIDING DRY-UP TURN OFF
POWER

The print heads were forced to standby
position to prevent them from drying out.

Operation cannot be continued. Switch the sub
power off, then back on. Opening the front 
cover while printing is in progress causes an
emergency stop. Never allow the print heads to
stand in this state.

SERVICE CALL **** An unrecoverable error occurred, or part
replacement that must be performed by a
service technician is required.

Note the number displayed, then switch off the
sub power. After you switch off the power,
contact a Service Technician.
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Problems with the Finishing Unit

Indicator Status and Error Codes

The Finishing Unit's status indicator lamp has several ways to indicate the current
status of the unit and/or unit errors.

GREEN - STEADY Finishing unit is ready.

GREEN -  1 FLASH Processing.

Wait for steady green signal before next plate is
put on the conveyor.

GREEN -  2 FLASHES
BUZZER SOUNDS

Plate on conveyor when oven is not ready.

Remove plate and wait for steady green signal
before plate is put on the conveyor.

GREEN -  3 FLASHES Plate too long or too short.

Remove plate.

RED -  1 FLASH Unit is not ready because conveyor and/or
oven sensor is covered.

Uncover both sensors.

RED -  2 FLASHES Program selection out of range.

Set correct program.

RED -  3 FLASHES
BUZZER SOUNDS

Bulb error - one or more bulb in the oven are
blown.

Power the unit off, replace bulb, then power the
unit on again.

RED -  4 FLASHES Motor regulation error - motor/conveyer is
blocked.

Power the unit off, remove obstacle, then power 
the unit on again.
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Problems with Printed Material
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